Avid Editing Application
®

ReadMe for Media Composer® v5.5.5, NewsCutter® v9.5.5,
and Symphony™ v5.5.5

IMPORTANT: Avid periodically makes software updates available for download on
Avid.com at the following location:www.avid.com/us/support/downloads. Please
check the above site regularly for information on available downloads for your
product.
Important Information

Avid® recommends that you read all the information in this ReadMe file thoroughly before
installing or using any new software release.
Important: Search the Avid Knowledge Base for the most up-to-date ReadMe file, which
contains the latest information that might have become available after the documentation
was published.
This document describes compatibility issues with previous releases, software installation
instructions, hardware and software requirements, and summary information on system and
memory requirements. This document also lists hardware and software limitations.
Important: This is a full version of the editing application. You should uninstall the previous
build from your system before you install Media Composer or Symphony v5.5.5 or
NewsCutter v9.5.5.
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Symbols and Conventions
Avid documentation uses the following symbols and conventions:
Symbol or Convention Meaning or Action

n

A note provides important related information, reminders,
recommendations, and strong suggestions.

c

A caution means that a specific action you take could cause harm to
your computer or cause you to lose data.

w

A warning describes an action that could cause you physical harm.
Follow the guidelines in this document or on the unit itself when
handling electrical equipment.

>

This symbol indicates menu commands (and subcommands) in the
order you select them. For example, File > Import means to open the
File menu and then select the Import command.
This symbol indicates a single-step procedure. Multiple arrows in a list
indicate that you perform one of the actions listed.

(Windows), (Windows
only), (Macintosh), or
(Macintosh only)

This text indicates that the information applies only to the specified
operating system, either Windows or Macintosh OS X.

Bold font

Bold font is primarily used in task instructions to identify user interface
items and keyboard sequences.

Italic font

Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font

Courier Bold font identifies text that you type.

Ctrl+key or mouse action

Press and hold the first key while you press the last key or perform the
mouse action. For example, Command+Option+C or Ctrl+drag.
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If You Need Help
If you are having trouble using your Avid product:
1. Retry the action, carefully following the instructions given for that task in this guide. It
is especially important to check each step of your workflow.
2. Check this ReadMe file for the latest information that might have become available after
the documentation was published. Also check online for the most up-to-date ReadMe
because the online version is updated whenever new information becomes available. To
view the online ReadMe, select ReadMe from the Help menu, or visit the Knowledge
Base at http://www.avid.com/readme.
3. Check the documentation that came with your Avid application or your hardware for
maintenance or hardware-related issues. In addition to the printed documentation
supplied with your editing application, the documentation is supplied in PDF format
when you install the application. Topics that you print from the Help have limited page
layout and formatting features. If you want to print a higher quality version of Help
information, Avid recommends that you print all or part of the PDF version of the
appropriate Avid manual included in the Online Library for your editing application. To
access the Online Library, select Help > Online Library from within your Avid editing
application.
4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available
24 hours per day, 7 days per week. Search the Knowledge Base to find answers, to view
error messages, to access troubleshooting tips, to download updates, and to read or join
online message-board discussions.

Fixed in Media Composer v5.5.5, Symphony v5.5.5,
and NewsCutter v9.5.5
The following were fixed in this release:
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➤

Bug Number: UDevC00170684. When playing an Edit While Capture clip approximately
60 seconds behind the capture point, the play monitor in NewsCutter displayed a “Capture in
Progress” message.

➤

Bug Number: UDevC00183413. (Macintosh) When working with a dual monitor system,
you could only change the color to black when using the Title Tool color picker.

➤

Bug Number: UDevC00172100. The editing application did not read the audio timecode
from AMA linked media.

Fixed in Media Composer v5.5.4, Symphony v5.5.4, and NewsCutter v9.5.4

➤

Bug Number: UDevC00182704. Exporting XDCAM QT Reference file times has been
improved considerably.

➤

Bug Number: UDevC00182444. The editing application would stop responding if you
exported to wmv format with a video profile only.

➤

Bug Number: UDevC00181352. Performing a Send to Workgroup between two editing
systems was much slower on the 9.5.3.x editing systems than on previous releases.

➤

Bug Number: UDevC00180337. When importing spanned XDCAM clips, the second to
last frame in was repeated and the last frame was cut.

➤

Bug Number: UDevC00183124. AMA linked QuickTime files might have stuttered during
playback.

➤

Bug Number: UDevC00170179. When performing a dynamic relink to XDCAM 50-bit
media after using the master clip in a sequence that was subsequently consolidated, the first
frame of the consolidated portion of the original master clip may have been pixelated.

➤

Bug Number: UDevC00182403. Igekami AMA material did not import with the correct
timecode.

➤

Bug Number: UDevC00182261. In some instances, dissolving across 2 channels performed
a cut rather than a dissolve.

Fixed in Media Composer v5.5.4, Symphony v5.5.4,
and NewsCutter v9.5.4
The following were fixed in this release:

➤

Bug Number: UDevC00181352. When using Send to Workgroup between two standalone
editing applications, the editing application would freeze at the end of the transfer.

➤

Bug Number: UDevC00175023. The media might have been distorted when AMA linking
to H.264 media.

➤

Bug Number: UDevC00175587. An XDCAM Hi-resolution import would fail if you used a
different device than was used for the proxy import.

➤

Bug Number: UDevC00181610. In some instances, Media Creation Settings were not
sticking.
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➤

Bug Number: . As of v5.5.4 and v95.4 you can now use a Dongle licensed for 7.0.

➤

Bug Number: UDevC00176500. In some instances, importing IMX30 MXF media did not
import audio tracks properly.

➤

Bug Number: UDevC00179205. When applying a Crossfade into Filler, the terminal value
is propagated from the outgoing clip into the filler.

➤

Bug Number: UDevC00180610 . You might have received “Disk access” errors when
importing files with invalid characters into NewsCutter.

➤

Bug Number: UDevC00180010. You could cut/copy and paste a password into the
Interplay login dialog. You can no longer copy or paste passwords, you must manually type
passwords.

➤

Bug Number: UDevC00178480. (Nitris DX) Performing a Punch-In from an optical ADAT
resulted in an “Audio_Sample_Rate” error when playing DNxHD media.

➤

Bug Number: UDevC00179735. If Dynamic Relink was enabled, checking out clips from
the Interplay Window could sometimes cause the editing application to get into a “Not
responding” state.

➤

Bug Number: UDevC00179720. Even numbered tracks with volume automation, panned
hard left when dissolved into filler.

➤

Bug Number: UDevC00179541. When performing a Post to Web, the URL placeholder
was not included in the web xml file.

Changed in Media Composer v5.5.3, Symphony
v5.5.3, and NewsCutter v9.5.3
The following updates were made in this release:
Installer Update

Both a full installer and a patch installer have been created for this release.
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•

Use the full installer if you are upgrading from a version older than v5.5.2 or v9.5.2.

•

Use the patch installer if you currently have v5.5.2 or v9.5.2 and you want to upgrade to
v5.5.3 or v9.5.3.

Changed in Media Composer v5.5.3, Symphony v5.5.3, and NewsCutter v9.5.3

Support for Macintosh Lion OS

This release of the editing application supports Macintosh OS v10.7. This release is
qualified with local storage only and Avid shared storage qualification is ongoing.

n

Co-install with Pro Tools is not supported at this time with v10.7.
The following limitations exists with the editing application with the Macintosh OS v10.7:
•

The Color Correction option “Eyedropper Picks from Anywhere in Application” does
not work. The color can be selected only from video images in the Source/Record
monitor.

•

This release is currently not qualified to run in an Avid Interplay environment with
Macintosh v10.7.

•

Send to Digidelivery does not work.

Upgrading to Macintosh Lion OS

Before you upgrade to the Macintosh Lion OS, note the following:
•

Make sure you uninstall your editing application first. (Deactivate if you are using
software licensing.)

•

Upgrade to the Macintosh Lion OS.

•

Install the editing application.

Advanced Keyframes

The following changes have been made to Advanced Keyframes:
•

The default interpolation option is linear, not spline.

•

You can add keyframes automatically to the start and end frames of an effect by
right-clicking the Effect Editor and selecting Add Start and End Keyframes.

•

Parameter sliders are present even if you have not added keyframes for that parameter or
if you have not selected a keyframe for that parameter. (In previous releases, the slider
would have disappeared.)

•

You can automatically add a keyframe by pressing an arrow key when a keyframe is
present but not active. This will add a keyframe at the location of the blue bar. If you
subsequently press an arrow key again, the keyframe will increment or decrement the
value of the parameter.

•

Now when an active keyframe is selected, selecting the 1, 2, 3, and 4 keys on the
keyboard enter numeric values for the parameter.

7

•

Using the left and right arrow keys decrements/increments the parameter values.
Holding Shift with these keys will multiply the value by a factor of 10.

•

Deselecting all keyframes in the parameter puts the focus to the top most master effect.

Fixed in Media Composer v5.5.3, Symphony v5.5.3,
and NewsCutter v9.5.3
The following were fixed in Avid Media Composer v5.5.3 and Avid Symphony v5.5.3 and
Avid NewsCutter v9.5.3.
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➤

Bug Number: UDevC00155946. Transcoding GFCAM 102M media to DNxHD, did not
always create new audio media.

➤

Bug Number: UDevC00158343. Advanced keyframes within effects templates changed
after checking in and checking out of Interplay.

➤

Bug Number: UDevC00158958. A fix was implemented to improve poor playback
performance in some AMA workflows.

➤

Bug Number: UDevC00159484. Occasionally, during capture of HDV, audio was replaced
by white noise.

➤

Bug Number: UDevC00157848. Previously, you could copy and paste only one locator at a
time.

➤

Bug Number: UDevC00157666. You might have received a communication error on a
second attempt to capture DV.

➤

Bug Number: UDevC00159501. Exported file names with 32 characters are no longer
renamed “Untitled.”

➤

Bug Number: UDevC00157848. You could only copy and paste one locator at a time.

➤

Bug Number: UDevC00157947. Previously, the editing application only recognized
8 tracks of track metadata.

➤

Bug Number: UDevC00149038. (Symphony) If you entered Color Correction mode and
did not make any changes and then left Color Correction mode and performed a render
operation, Color Correction precomputes did not stick.

Fixed in Media Composer v5.5.3, Symphony v5.5.3, and NewsCutter v9.5.3

➤

Bug Number: UDevC00156292. You could not delete audio files from a QuickTime
reference export when the editing application was active.

➤

Bug Number: UDevC00157491. Occasionally, when loading a sequence in the Timeline,
the sequence was duplicated and you were prompted to promote to Advanced Keyframe.

➤

Bug Number: UDevC00158519. With an AJA Io Express, when performing a digital cut,
the reference lock indicator did not work.

➤

Bug Number: UDevC00158908. (Macintosh) Occasionally, when trying to quit the editing
application, the system would hang.

➤

Bug Number: UDevC00158867. Software deactivation was not working on systems with a
Japanese OS or an English OS with a Japanese locale.

➤

Bug Number: UDevC00156551. Occasionally, rendered audio dissolves when combined
with auto gain would spike after checkin/checkout.

➤

Bug Number: UDevC00158355. If you duplicated a sequence, you would lose the audio
track monitoring selection. For example, if you created a sequence with 4 tracks, then turned
off two tracks and duplicated the sequence, the duplicated sequence would show all 4 tracks
enabled.

➤

Bug Number: UDevC00158753. Making a subsequence with an assigned subclip keystroke
resulted in Bus Thread errors.

➤

Bug Number: UDevC00109324. When using Send To DVD with a 720p/50 sequence, the
TV standard was set to NTSC instead of PAL.

➤

Bug Number: UDevC00158074. Locking closed bins created a LCK without an owner.

➤

Bug Number: UDevC00157761. The 3D Warp scale parameter did not work properly.

➤

Bug Number: UDevC00156354. Some Unicode symbols did not paste in Marquee or the
Title Tool.

➤

Bug Number: UDevC00156322. (Macintosh) Send To templates now save properly.

➤

Bug Number: UDevC00155509. Myriad and Minion fonts did not show up in the SubCap
Effect.

➤

Bug Number: UDevC00155229. When connected to the Avid Mojo DX you no longer
receive a kernel panic error when you start the MacBook Pro.
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➤

Bug Number: UDevC00159392. Autosync did not work with sequences containing
Multichannel audio.

➤

Bug Number: UDevC00148380. Occasionally, after closing out of a project in the editing
application, the Video Output Tool settings reverted back to the default settings.

➤

Bug Number: UDevC00154686. (Macintosh) You might have experienced A/V sync issues
while playing back 9-way multicam in HD Y/G mode.

➤

Bug Number: UDevC00155350. Saving bins might have taken a long time and a “file
system busy” message appeared.

➤

Bug Number: UDevC00154604. Some imported media looked pixelated. The same media
imported via AMA method, did not look pixilated. The media now imports properly.

➤

Bug Number: UDevC00151941. Titles created in the Title tool might have shifted to the
right until the editing application was restarted. (New user must be created.)

➤

Bug Number: UDevC00139572. When Video Output settings were saved as a site setting, a
new copy of the Video Output settings was made each time the project was opened.

➤

Bug Number: UDevC00152460. The frame information in Record Monitor displayed
Sequence Information for both Sequence and Source.

➤

Bug Number: UDevC00152210. When selecting Send to > Encoding > Sorenson Squeeze,
an Options button should not have been selectable.

➤

Bug Number: UDevC00155881. Video Output tool options remained as SD when the
project format was toggled to HD.

➤

Bug Number: UDevC00156339. (Mojo SDI) If Fast Scrub was enabled you might have
received a Fatal Assert error when performing audio scrub.

➤

Bug Number: UDevC00158520. Exporting ProRes QuickTime AMA using Same as
Source resulted in Bus errors.

➤

Bug Number: UDevC00153864. Automatic Duck AAF files did not import into the Avid
editing application v5.5.1.

➤

Bug Number: UDevC00155905. When applying a quick transition (dissolve) from IN to
OUT, some of the automatically applied transitions would not render. This issue has been
fixed. Additionally, when applying a quick transition from IN to OUT, you might see the
following message to inform you about the number of transitions which were applied

Fixed in Media Composer v5.5.3, Symphony v5.5.3, and NewsCutter v9.5.3

successfully and the number of transitions which were skipped: “X transition(s) added
successfully. Y skipped due to zero-length handles or user cancellation.” If all transitions
were applied successfully, no message is generated.

➤

Bug Number: UDevC00154711. You might have received an error when importing
XDCAM files when Essence Marks were imported as locators.

➤

Bug Number: UDevC00158279. Bit Depth information for an imported audio file
disappeared after you closed and then reopened a bin.

➤

Bug Number: UDevC00158478. (NewsCutter NRCS Tool) If the slog name used to name a
bin exceeded 27 characters, you would receive an error. Now the bin will be created with a
truncated name.

➤

Bug Number: UDevC00158631. (Macintosh) AMA files on Avid MediaNetwork were not
highlighted yellow in bin.

➤

Bug Number: UDevC00158189. If you created a new sequence after sifting a bin, you
might have received a bus error.

➤

Bug Number: UDevC00155998. When Dissolve Midpoint Attenuation was set to Constant
Power in the Audio Project settings, Stereo Audio resulted in different levels between L and
R channels.

➤

Bug Number: UDevC00156514. The blue line in the Timeline that warns you if the system
is having difficulty with realtime playback was appearing on NewsCutter software only and
NewsCutter with Adrenaline systems even when there was no playback issue. This has been
fixed.

➤

Bug Number: UDevC00149140. The Client Monitor did not Output when parked on a
frame in Color Correction Mode.

➤

Bug Number: UDevC00153932. Occasionally, when importing P2 media, the destination
drive listed in the bin would disappear.

➤

Bug Number: UDevC00156848. The editing application did not correctly handle video fill
in QuickTime reference exports.

➤

Bug Number: UDevC00155928. Occasionally, the system would crash when importing a
user setting that was not already in the User folder.

➤

Bug Number: UDevC00135093. Some Desktop Play Delay setting or Video Display
settings were not sticking.
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➤

Bug Number: UDevC00128806. Numeric keypad entries up to 29 in a 720p 59.94 project
were incorrect.

➤

Bug Number: UDevC00156861. When performing an audio mixdown, channels were
swapped during Send to Playback.

➤

Bug Number: UDevC00156132. The Pan & Zoom effect produced a vertical jump in the
path toward the last keyframe when set to Spline.

➤

Bug Number: UDevC00156563. When using a 3D Title, generated by the Title Tool with a
path movement above or nested with a Sapphire Scan lines effect, the title alpha drifted
during the 3D move.

➤

Bug Number: UDevC00157907. Freeze frame defaulted to the highest drive letter rather
than to the drive letter that was set in the Render tab of the Media Creation Settings.

➤

Bug Number: UDevC00135093. Some Desktop Play Delay setting or Video Display
settings were not sticking.

➤

Bug Number: UDevC00157907. Freeze frame defaulted to the highest drive letter rather
than to the drive letter that was set in the Render tab of the Media Creation Settings.

➤

Bug Number: UDevC00145580. Disabling or enabling track monitoring in the Audio Tool
did not work with multiple groups.

➤

Bug Number: UDevC00156501. Occasionally, when changing export settings within the
Export dialog window, you might have received a “malloc_error_break to debug” error.

➤

Bug Number: UDevC00149292. When performing an Export to XDCAM device, if you
eject a disk and then insert a second disk, the disk name still indicates the first disk.

➤

Bug Number: UDevC00156707. When Fast Scrub was enabled, the Field 2 indicator did
not always display in the monitor when stepping through by field.

➤

Bug Number: UDevC00155211. Bins on Unity were slow to open and rename.

➤

Bug Number: UDevC00155816. Random “ADMCMaster Record...CONSISTENCY
CHECK FAILURE” errors occurred. Occasionally this occurred at the start of play or when
dragging a clip into the Timeline from the source viewer with Fast Scrub active.

➤

Bug Number: UDevC00147272. In previous releases, Animatte effects might not have
exported properly.

Fixed in Media Composer v5.5.3, Symphony v5.5.3, and NewsCutter v9.5.3

➤

Bug Number: UDevC00151396. Dragging IMX 50 content from an FTP browser into the
editing application resulted in the editor “Not responding.”

➤

Bug Number: UDevC00148652. (Macintosh) Playing back XDCAM media on Ethernet
attached clients caused “Decomp stream” errors.

➤

Bug Number: UDevC00123549. (Macintosh) The editing application did not always follow
the target drive selected when importing audio files from a CD.

➤

Bug Number: UDevC00154363. Performing an audio Punch-in shifted tracks in the
Timeline after the recording when using sync locks.

➤

Bug Number: UDevC00154213. Stereo audio tracks patched to A1 if you changed the
Timeline view. This resulted in an Assertion Failed error.

➤

Bug Number: UDevC00150593. Adding an EQ effect on a clip in the Source Window
made the waveform appear distorted.

➤

Bug Number: UDevC00156401. SD footage might have appeared soft or blurry in an HD
project.

➤

Bug Number: UDevC00152950. Performing a batch import of BWF files resulted in a
wrong start Timecode for clips.

➤

Bug Number: UDevC00151382. The quality of the output did not look good when
downconverting some HD media to SD.

➤

Bug Number: UDevC00150246. You could not change the Transition time for some Plasma
Wipe effects.

➤

Bug Number: UDevC00157721. (Macintosh) When exporting to ALE, the popup menu
was not selectable. This is no longer grayed out.

➤

Bug Number: UDevC00156286. You received a FatalAbort Assertion error when checking
in a sequence that contained a subclip that was created when the master clip was still being
captured.

➤

Bug Number: UDevC00154747. Ancillary Data was visible in the Source monitor only
when you were in Draft or Best Performance Mode.

➤

Bug Number: UDevC00156598. (NewsCutter) Traditional Chinese characters did not
display correctly in the NRCS Tool.
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➤

Bug Number: UDevC00157356. (AJA Io Express) You might have received audio
communication errors when scrubbing.

➤

Bug Number: UDevC00156630. Sequences that contained an empty A1 track were
corrupted when written back to P2 card.

➤

Bug Number: UDevC00155215. If the border was not selected for a 3D warp you could not
see changes to position.

➤

Bug Number: UDevC00150443. (Video Satellite) In Sample plot view, the Waveform
disappeared when pressing stop from Pro Tools.

➤

Bug Number: UDevC00155882. Performing a Digital Cut prompted for a sample rate
conversion even when the entire marked segment matched the project’s sample rate.

➤

Bug Number: UDevC00154233. When editing an existing Marquee title, there was no
option to save the title to the bin unless you closed the Marquee application.

➤

Bug Number: UDevC00155941. (NewsCutter) When performing a Send to Playback,
material was consolidated every time if the material was on an ISIS workspace which was
not mounted or was mounted with an UNC path.

➤

Bug Number: UDevC00156346. (Windows Vista) You might have received an “Avid Editor
has stopped working” error when exiting the editing application with the AudioSuite
window open.

➤

Bug Number: UDevC00157543. Performing an XDCAM HD import did not always import
locators.

➤

Bug Number: UDevC00158252. Interplay folder settings did not always persist after
relaunching the editing application or if they were saved as site settings.

➤

Bug Number: UDevC00158397. There was an inconsistency between NewsCutter and
Media Composer when entering Trim mode. Media Composer would revert to Y/G mode
when entering Trim mode. NewsCutter did not drop video quality when entering trim mode.
Now both editing applications do not drop video quality when entering trim mode.

➤

Bug Number: UDevC00158628. (Macintosh) Bin locks were not working as expected
when the editing application scanned AMA files.

➤

Bug Number: UDevC00156384. Occasionally, when performing an edit while capture, a
“Capture in Progress” slide would appear in the Source monitor for frames that had already
been captured.

Changed in Media Composer v5.5.2, Symphony v5.5.2, and NewsCutter v9.5.2

➤

Bug Number: UDevC00158832. Using the Up and Down arrow keys did not change
parameters in the Effect Editor if the advanced keyframe graph was closed.

Changed in Media Composer v5.5.2, Symphony
v5.5.2, and NewsCutter v9.5.2
The following updates were made in this release:
AMA Plug-In Installers

•

With the release of v5.5 and v9.5, the AMA Plug-Ins the AMA Plug-Ins are unbundled
from the Avid editor installers, with the exception of the AMA QuickTime plug-in. This
allows AMA plug-in updates to be released when needed without relying on an Avid
editing release. After you install your Avid editing application, be sure to go to
www.avid.com/ama to download the latest AMA plug-ins that are qualified with your
Avid editing application. To see a list of AMA plug-ins installed on your system, select
Tools > Console, and type: AMA_ListPlugins.

•

Currently there is an issue with the installation of the Sony AMA plug-ins. The Sony
AMA Plugins do not install on the Windows versions of Media Composer 5.5.2,
NewsCutter 9.5.2, or Symphony 5.5.2. For information on this issue, see the following
article.
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=408111

PhraseFind and ScriptSync

•

A PhraseFind and ScriptSync 30 day trial has been included with this release.

•

The PhraseFind and SciptSync features are no longer separate installers. They are
included with the editing application, but you must purchase the feature separately to
obtain the PhraseFind or ScriptSync serial number. For more information search for
“Purchasing and Activating PhraseFind” or “Purchasing and Activating SciptSync” in
the Help.

•

If you had a previous version of PhraseFind, note that the location of the language packs
is now <CommonFiles>\Avid\Phonetic.

Avid QuickTime Codec Installers Package v2.3.4

Avid QuickTime v2.3.4 Codec Installer changes have fixed the following:
•

UDevC00151173:DNxHD media exported as QuickTime Reference did not play in
QuickTime on the Westmere Macintosh systems.

•

In the Custom QuickTime Export window, the DV100 Export option did not contain
720p50 as a selection. The selections were 1080i50, 1080i59.94 and 720p59.
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For information on the v2.3.4 codec installers, see
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=392963
Keyframe Changes

The following changes have been added to the advanced keyframe feature.
•

When adding keyframes using the advanced keyframe feature, the Avid editing
application uses the linear interpolation method as the default. Previously, the default
interpolation used the spline method.

•

When you add keyframes using the advanced keyframe feature, you now have the option
of adding keyframes to the start frame and end frame of your effect. To add start and end
keyframes, right-click in the Effect Editor and select Add Start and End Keyframes. You
can apply this selection to the parameter track, the group track, or the effect master
track. The option is not available for the effect master track of a color correction effect.

To add keyframes at the start and end of an effect:

1. Right-click one of the following:
t

The keyframe graph or the parameter track for an individual parameter, to add start
and end keyframes to that parameter only.

t

A parameter group track, to add start and end keyframes to every keyframeable
parameter in that group.
The track displays the text “Apply to Group.”

t

The effect track, to add start and end keyframes to every keyframeable parameter in
the effect.
The track displays the text “Apply to All.”

2. Select Add Start and End Keyframes.
Active keyframe indicators appear at the beginning and the end of the effect in all
appropriate tracks. For more information on where keyframe indicators appear, see
“Understanding Advanced Keyframe Display” in the Help.

Fixed in Media Composer v5.5.2, Symphony v5.5.2,
and NewsCutter v9.5.2
The following have been fixed in this release:

➤
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Bug Number: UDevC00154686. (Macintosh) You might have experienced A/V sync issues
while playing back 9-way multicam in HD Y/G mode.

Fixed in Media Composer v5.5.2, Symphony v5.5.2, and NewsCutter v9.5.2

➤

Bug Number: UDevC00150282. Occasionally, when editing a title using the Title Tool, the
application would beep and ignore the spacebar and Caps Lock keys.

➤

Bug Number: UDevC00155875. You might have received Access violations or bus errors
when creating subclips while capturing.

➤

Bug Number: UDevC00153263. Saving bins in the v5.x/9.x version of the editing
application was slower than the same operation in the 4.x/8.x version.

➤

Bug Number: UDevC00153230. When performing an edit while capture, the media was
offline when importing the AAF file of the capturing clip.

➤

Bug Number: UDevC00153905. Exporting an XDCAM sequence containing a title to
AirSpeed Multi Stream might have hung the editing application, resulting in the transfer
being cancelled by the AirSpeed Multi Stream.

➤

Bug Number: UDevC00153505. The bottom half of your image might have appeared
corrupted if you set the console command ForceRGBCompositing ON when the Timeline
display or Digital cut was set to 10-bit output.

➤

Bug Number: UDevC0153386. (Macintosh) The editing application would hang after
capturing SD. This occurred with systems connected to Adrenaline.

➤

Bug Number: UDevC00154856. When sending to playback, you might have received
intermittent “DAE disconnect” errors.

➤

Bug Number: UDevC00152912. You might have seen a “Main Thread” error when
performing a PhraseFind search on lengthy text. Deleting the last several words in a lengthy
text search may cause valid results to return.

➤

Bug Number: UDevC00153837. Changes made to the text of a script through cut, copy and
paste were not reflected in subsequent bin searches.

➤

Bug Number: UDevC00153800. PhraseFind .pat files were being created for off-line
AMA audio clips.

➤

Bug Number: UDevC00153167. Consolidating or Transcoding AMA clips while
connected to a local device was slow while .pat files were being created. With this release,
the .pat file creation process is paused while Consolidating/Transcoding and resumes when
the Consolidating/Transcoding is finished.

➤

Bug Number: UDevC00154012. Loading a title created with an OMF resolution into the
source/record monitor, resulted in CORE_CONSISTENCY_CHECK_FAILURE error.
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➤

Bug Number: . Bug Number: UDevC00148236. Occasionally, the editing application
would lose connection to the Command 8.

➤

Bug Number: UDevC00153265. The Effects editor curve type default has changed from
Spline to Linear.

➤

Bug Number: UDevC00152774. Occasionally, adding a BCC effect changed the location
of the alpha key.

➤

Bug Number: UDevC00147985. Performing an Undo no longer reverts paint parameters to
their default.

➤

Bug Number: UDevC00154715. Applying a transition effect did not place the animation
keyframes in the proper place.

➤

Bug Number: UDevC00153922. (Macintosh) MXF files that were created with an old
SMPTE label did not appear in the Media Tool. This has been fixed.

➤

Bug Number: UDevC00153509. (Macintosh) Previously, you could not write to an ethernet
attached client.

➤

Bug Number: UDevC00149212. The Paint Brush in Animatte did not key out the top left
corner of an image. This has been fixed.

➤

Bug Number: UDevC00152553. (Symphony) A sequence with multiple rendered effects
was causing the memory usage to climb and the system would have to be restarted.

➤

Bug Number: UDevC00153267. Start and End Keyframes options are now selectable in the
Keyframes shortcut menu.

➤

Bug Number: UDevC00155041. The KN Start and Sound TC values revert after being
changed if a bin containing a cloned clip is opened.

➤

Bug Number: UDevC00151239. When performing a digital cut, if you had “Stop on
Dropped Frames” selected, the editing application stopped the Digital Cut and alerted you to
the skipped frames, but left the deck recording until you closed the error dialog.

➤

Bug Number: UDevC00146440. Performing an ExpertRender forced a render of titles that
in previous releases did not require a render.

➤

Bug Number: UDevC00131445. The “Preserve Varicam Frames” option was missing in the
Capture tool.

Fixed in Media Composer v5.5.2, Symphony v5.5.2, and NewsCutter v9.5.2

➤

Bug Number: UDevC00150816. Some Traditional Chinese characters did not display
correctly in the NRCS tool.

➤

Bug Number: UDevC00152262. While in Script view, if you double-clicked to open a bin
containing more than 9 master clips, you did not receive the message asking if you wanted to
open all clips. All clips were opened. Now you receive the message asking if you want to
open all clips.

➤

Bug Number: UDevC00153042. You might have received an
AUDIOEXPORT_FILE_TOO_LARGE error when exporting a long sequence with 24 bit
audio and Same as Source options selected.

➤

Bug Number: UDevC00153975. (NewsCutter) P2 AMA clips did not turn yellow when
Dynamic Relink was enabled.

➤

Bug Number: UDevC00152992. You might have received Assertion Failed errors when
working with sequences containing renders.

➤

Bug Number: UDevC00115645. (Macintosh) Print Frame produced a distorted image with
blue tint.

➤

Bug Number: UDevC00152094. (Interplay) If you were working with Dynamic Relink,
the editing application might have been relinking to an incorrect media file.

➤

Bug Number: . UDevC00151401, UDevC00150425: Exporting AMA P2 clips back to a P2
device caused a system crash or incorrect playback.

➤

Bug Number: . UDevC00150812 Occasionally, a clip in a Multicam sequence linked to the
incorrect quad.

➤

Bug Number: UDevC00153310. Splicing in clips in the Timeline resulted in a spike in the
memory counter. This has been fixed.

➤

Bug Number: UDevC00151936. If you created a title, added locators and then exported the
locators, you might have received a “disk_invalid” or “invalid_file_name” error. This has
been fixed.

➤

Bug Number: UDevC00150243. Publishing to a Nexio Server resulted in an “Export of
temporary file failed. Send to Playback will not continue” error.

➤

Bug Number: UDevC00153446. Transitions saved to Quick Transitions bin did not show
up in the Quick Transitions dialog box.
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➤

Bug Number: UDevC00153341. If you added a Quick Dissolve from the Timeline button,
the dissolve immediately cut to the next clip instead of dissolving.

➤

Bug Number: UDevC00153001. Batch capturing HDCAM SR AMA linked clips might
have resulted in bus errors.

➤

Bug Number: UDevC00145792. A Cineon graphic export did not retain changes to black
and white values.

➤

Bug Number: UDevC00149026. The duration values in Transition effect templates were
resetting once they were checked in and out of Interplay.

➤

Bug Number: UDevC00150183. (Macintosh) You might have received Bus errors when
using Trim Mode.

➤

Bug Number: UDevC00147317. Performing an Audio Punch-in from an AES/EBU source
resulted in brief silence heard on the monitor outputs after the in point.

➤

Bug Number: UDevC00149877. Performing an extract-edit on a sequence that referenced
AMA clips caused sluggishness.

➤

Bug Number: UDevC00150186. Batch import was not working properly when AMA was
disabled.

➤

Bug Number: UDevC00153101. (Macintosh) When performing an audio punch-in using an
external audio interface, you might have heard a delayed signal echo.

➤

Bug Number: UDevC00151939. Exported locators did not include timecode values.

➤

Bug Number: UDevC00147379. The audio sample rate might not have converted when
performing a WMA import even when the “convert sample rate on import” setting was
selected.

➤

Bug Number: UDevC00152365. (NewsCutter) The editing application might have frozen
during export when performing a Post To Web using ProEncode.

➤

Bug Number: UDevC00150610. You might have received Out of Memory errors when
checking out sequences from Interplay.

➤

Bug Number: UDevC00149024. Audio track labels were lost when you performed a
checkin/checkout of Interplay.

Fixed in Media Composer v5.5.2, Symphony v5.5.2, and NewsCutter v9.5.2

➤

Bug Number: UDevC00144404. (Macintosh) Clip name is not selected after creating a
subclip.

➤

Bug Number: UDevC00149488. If you layered Sapphire effects on top of each other, the
bottom effect did not merge with the top one.

➤

Bug Number: UDevC00151473. Playing back OMF JPEG on systems connected to ISIS
shared storage was slow.

➤

Bug Number: UDevC00151767. (Macintosh) After installing Boris Continuum Complete
v6, the Disc Label field was grayed out for XDCAM import.

➤

Bug Number: UDevC00152780. Some imported AVCHD files caused an “assertion” error.

➤

Bug Number: UDevC00124296. Capturing 720p/23.98 Varicam material without pull
down applied resulted in ”BuildComposition Max default audio sample duration exceeded”
errors.

➤

Bug Number: UDevC00147649. SDII Audio files were not recognized by newer Avid
editing systems.

➤

Bug Number: UDevC00149006. Performing a batch import ignored a changed clip length
if “Override clip settings with current settings” was selected.

➤

Bug Number: UDevC00147615. QuickTime same as source exports with DV25 420 media
may have resulted in video displaying as Wrong Format.

➤

Bug Number: UDevC00152988. Audio only AMA segments might not have been
transcoded properly.

➤

Bug Number: UDevC00146008. If you reopened a Marquee title containing soft drop
shadows, the shadows were shifted.

➤

Bug Number: UDevC00151521. The SubCap effect caused unwanted drop shadows.

➤

Bug Number: UDevC00150252. The Miranda DV bridge transcoder was not being
recognized in the Avid editing application.

➤

Bug Number: UDevC00149484. If you recorded automation gain, and then recorded
automation a second time over the same segment using your Avid Artist controller while in
Touch mode, the resulting automation might have included unexpected audio keyframes.
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➤

Bug Number: UDevC00145887. In some instances, the Quick Transition window did not
recognize the type of transition in the Timeline.

➤

Bug Number: UDevC00151549. In a 24p Pal project, performing a Digital Cut to playback
at 25 resulted in out of sync audio.

Before Installing the Editing Application
Read through the following procedures prior to installing the editing application.
•

If you are upgrading from a previous version of the editing application, go to
“Upgrading from a Previous Version of the Editing Application” on page 22 to
determine if you can upgrade. Then see the Installation Guide for Avid Editing
Applications.

•

If you are a new user and have never installed the editing application on your system,
see the Installation Guide for Avid Editing Applications. This document ships with the
editing application kit. If you did not receive a physical kit, this document is also on the
download page and the Knowledge Base.

Upgrading from a Previous Version of the Editing Application
Use the following procedures if you are upgrading from a previous version of the editing
application:
•

Determining If the Editing Application Can Be Installed On Your System

•

Cleaning up Old Folders Before Installation (Only perform this if upgrading from a
version prior to Media Composer v3.0, Symphony v3.0 or NewsCutter v7.0)

Determining If the Editing Application Can Be Installed On Your System
Use the following information to determine if the editing application can be installed on
your system.
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•

You can upgrade from Media Composer v2.7.x, Symphony Nitris v1.7x, and
NewsCutter v6.7.x.

•

Do not perform an OS upgrade process and then install the editing application. The OS
must be a clean install, not an upgrade.

Notes on Windows Vista and Windows 7 OS

Cleaning up Old Folders Before Installation (Only perform this if upgrading from a
version prior to Media Composer v3.0, Symphony v3.0 or NewsCutter v7.0)
Do the following to clean up old folders before you install the new ones if you are
performing an upgrade from a version prior to Media Composer 3.0, Symphony 3.0, or
NewsCutter 7.0.
To clean up folders:

1. Before installing the editing application, you need to uninstall your old version and any
version of FilmScribe, EDL Manager, MediaLog, and Avid Log Exchange.
2. Remove the following Registry keys on your system if they still exist after the
uninstallation process.
HKLM/Software/Avid Technology/<productname>
HKLM/Software/Avid Technology/AVX Plug-ins
3. From the following folders, remove any folders that do not have custom data in them
that you want to keep. If you do have custom data, copy the data to the new locations
after you install the new editing application.
C:/Documents and Settings/AllUsers/ApplicationData/Avid/<productname>
C:/Program Files/Avid/<ProductName>
(Windows Vista) C:/ProgramData/Avid/<Productname>

Notes on Windows Vista and Windows 7 OS
Note the following topics if you are running the editing application on the Windows Vista or
Windows 7 OS.

Disabling Desktop Compositing
When the Avid editor is launched you might see a dialog box asking you to disable desktop
compositing. You can disable it without adversely affecting the Avid editing application.
You can choose to disable it and continue with your editing session. The dialog will appear
once you relaunch the application unless you disable the option.
To disable the desktop compositing:

1. Access the Control Panel.
2. Double-click System.
3. Click Change Settings.
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4. Click the Advanced tab.
5. Under the Performance area, click Settings.
6. Uncheck “Enable desktop composition.”
The dialog box requesting you to disable desktop compositing does not appear the next
time you launch the editing application.

User Access Control Setting
Windows Vista and Windows 7 include User Access Control (UAC), which makes you
aware of changes that will be made to your computer letting you decide to allow the changes
or not. Avid recommends that you leave UAC ON. This feature is turned on by default.

Standard User
You need to first install the editing application as an Administrator. If you are in a Shared
Storage environment, mount your workspaces as an Administrator. You may then log off and
log back in as a Standard user, if necessary.

Windows Sidebar
If the Windows Sidebar is enabled, you might see flickering on the Timeline monitor when
you stop playback. You should disable Windows Sidebar:
To disable the Windows Sidebar:

1. Right-click the Sidebar or Sidebar icon, and select Properties.
2. Deselect “Start Sidebar when Windows starts.”
3. Right-click the icon, and select Exit to close the sidebar.

Notes on Software Licensing
Activating Your Avid Editing Application
You activate your software using the Avid Activation tool, which opens when you first
launch your editing application. For more information on activating your software, see the
Installation Guide for Avid Editing Applications.
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Notes on Software Licensing

If You Upgrade Your Operating System
If you need to upgrade your operating system after you install your Avid editing application,
first deactivate your software. After you upgrade your operating system and, if required,
reinstall your application, you can reactivate your software. For information on activating
and deactivating your software license, see the Installation Guide for Avid Editing
Applications.

Laptop Network Settings
Your software license uses information from your system’s network configuration. Some
laptops disable the Network Interface Card (NIC) when connecting to the Internet through a
wireless network connection. If you run your Avid editing application on a laptop, be sure
that your NIC and wireless configuration is always the same as when you originally
activated your software. See the user assistance for your computer for information on
changing network settings.

Using the GetLicenseInfo Utility
Avid provides a utility program — GetLicenseInfo.exe — that retrieves information specific
to your license. This is useful if you no longer have the original license information or if you
need to provide this information to Avid Customer Support. The license information
retrieved by the utility depends on your system, but it can include the following:
•

Avid editing product name

•

License type

•

Status

•

System ID

•

Serial number (for security reasons, only part of the serial number is displayed)

•

Avid machine ID

To retrieve license information:

1. Navigate to one of the following locations:
t

(Windows) Program Files\Avid\Utilities\GetLicenseInfo

t

(Macintosh) Applications/Utilities/Avid Utilities/GetLicenseInfo

2. Double-click GetLicenseInfo.exe.
A terminal window opens and displays your license information.
3. Copy the appropriate license information, and then close the terminal window.
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Qualified Hardware and Operating Systems
The following tables provide the information on qualified Windows and Macintosh
hardware. The following tables also list the qualified Operating Systems. Depending upon
your hardware the qualified Operating Systems are:
•

Windows XP 32 (SP3)

•

Windows Vista 64 (SP2) (Business and Ultimate)

•

Windows 7 64-bit (SP1) (Professional)

•

(Media Composer and Symphony) Macintosh Snow Leopard v10.6.7, v10.6.8 and Lion
v10.7, 10.7.3, 10.7.5

Some features are processor-intensive and require specific hardware. See “Feature
Performance” on page 50 for more info.

Qualified PC Workstations with Avid Media Composer and
Avid NewsCutter
The following PC Workstations are qualified with Avid Media Composer v5.5.1 and higher
and NewsCutter v9.5.1 and higher.
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Qualified PC
Hardware

Graphics Card

Qualified OS

Supported with

HP z800 Dual 6 Core,
2.66 GHz

NVIDIA Quadro
FX 3800

Windows XP 32
Windows Vista 64-bit
Windows 7 64

Software Only
Adrenaline (See “Required
Hotfix Info” on page 37)
Nitris DX
Mojo DX
Mojo SDI (See “Required
Hotfix Info” on page 37)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

HP z800 Dual 6 Core,
2.66 GHz

NVIDIA Quadro
FX 4000

Windows XP 32
Windows Vista 64-bit
Windows 7 64

Software Only
Adrenaline (See “Required
Hotfix Info” on page 37)
Nitris DX
Mojo DX
Mojo SDI (See “Required
Hotfix Info” on page 37)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

Qualified Hardware and Operating Systems

Qualified PC
Hardware

Graphics Card

Qualified OS

Supported with

HP z800 Dual Quad
Core, 2.93 GHz

NVIDIA Quadro
FX 4800

Windows XP 32
Windows Vista 64-bit
Windows 7 64

Software Only
Adrenaline (See “Required
Hotfix Info” on page 37)
Nitris DX
Mojo DX
Mojo SDI (See “Required
Hotfix Info” on page 37)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

HP z800 Dual Quad
Core, 2.93 GHz

NVIDIA Quadro
FX 4000

Windows XP 32
Windows Vista 64-bit
Windows 7 64

Software Only
Adrenaline (See “Required
Hotfix Info” on page 37)
Nitris DX
Mojo DX
Mojo SDI (See “Required
Hotfix Info” on page 37)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

HP z800 Dual Quad
Core, 2.66 GHz

NVIDIA Quadro
FX 4800

Windows XP 32
Windows Vista 64-bit
Windows 7 64

Software Only
Adrenaline (See “Required
Hotfix Info” on page 37)
Nitris DX
Mojo DX
Mojo SDI (See “Required
Hotfix Info” on page 37)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

HP z800 Dual Quad
Core, 2.66 GHz

NVIDIA Quadro
FX 4000

Windows XP 32
Windows Vista 64-bit
Windows 7 64

Software Only
Adrenaline (See “Required
Hotfix Info” on page 37)
Nitris DX
Mojo DX
Mojo SDI (See “Required
Hotfix Info” on page 37)
Matrox MX02 Mini
AJA Io Express (Win 7 only)
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Qualified PC
Hardware

28

Graphics Card

Qualified OS

Supported with

HP z400 Single 6 core
3.33 GHz

NVIDIA Quadro
FX3800 1GB
GPU

Windows XP 32
Windows Vista 64-bit
Windows 7 64

Software Only
Nitris DX
Mojo DX
Mojo SDI (See “Required
Hotfix Info” on page 37)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

HP z400 Single 6 core
3.33 GHz

NVIDIA Quadro
FX 2000

Windows XP 32
Windows Vista 64-bit
Windows 7 64

Software Only
Nitris DX
Mojo DX
Mojo SDI (See “Required
Hotfix Info” on page 37)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

HP z400 3.06 GHz

NVIDIA Quadro
FX 3800

Windows XP 32
Windows Vista 64-bit
Windows 7 64

Software Only
Nitris DX
Mojo DX
Mojo SDI (See “Required
Hotfix Info” on page 37)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

HP z400 3.06 GHz

NVIDIA Quadro
FX 2000

Windows XP 32
Windows Vista 64-bit
Windows 7 64

Software Only
Nitris DX
Mojo DX
Mojo SDI (See “Required
Hotfix Info” on page 37)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

HP z400 Single Quad
Core, 2.93 GHz

NVIDIA Quadro
FX 3800

Windows XP 32
Windows Vista 64-bit
Windows 7 64

Software Only
Adrenaline (See “Required
Hotfix Info” on page 37))
Nitris DX
Mojo DX
Mojo SDI (See “Required
Hotfix Info” on page 37)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

Qualified Hardware and Operating Systems

Qualified PC
Hardware

Graphics Card

Qualified OS

Supported with

HP z400 Single Quad
Core, 2.93 GHz

NVIDIA Quadro
FX 2000

Windows XP 32
Windows Vista 64-bit
Windows 7 64

Software Only
Adrenaline (See “Required
Hotfix Info” on page 37))
Nitris DX
Mojo DX
Mojo SDI (See “Required
Hotfix Info” on page 37)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

HP z200 Intel® Core™ NVIDIA Quadro
i5-660 3.33 4MB/1333 600
Dual-Core

Windows 7 64

Software Only

Dell™ T5500 Dual,
2.93GHz Quad Core

NVIDIA Quadro
FX 4800

Windows Vista 64-bit
Windows 7 64

Software Only
Nitris DX
Mojo DX
Mojo SDI (requires additional
1394b card - StarTech
PEX1394B3)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

Dell T3500 Single
Quad Core, 2.93GHz

NVIDIA Quadro
FX 3800

Windows Vista 64-bit
Windows 7 64

Software Only
Nitris DX
Mojo DX
Mojo SDI (requires additional
1394b card - StarTech
PEX1394B3)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

Dell T5400 Dual Quad NVIDIA Quadro
Core, 2.50 to 3.16 GHz FX 3700

Windows XP 32
Windows Vista 64

Software Only
Adrenaline
Nitris DX
Mojo DX
Mojo SDI
Matrox MX02 Mini

Dell T3400 Core 2 Duo, NVIDIA Quadro
2.33 or 2.66GHz
FX 570

Windows XP 32
Windows Vista 64

Software Only
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Qualified PC
Hardware

HP xw8600

Graphics Card

Qualified OS

Supported with

NVIDIA Quadro
FX 3700

Windows XP 32

Software Only
Nitris DX
Mojo DX
Adrenaline
Mojo SDI
Mojo
Matrox MX02 Mini
AJA Io Express (Win 7 only)

Windows Vista 64
Windows 7 64

HP xw8400 Dual Quad NVIDIA Quadro
Core, 2.33, 2.66, or
FX 1500 or
3.0MHz
NVIDIA Quadro
FX 3500 or
NVIDIA Quadro
FX 3700

Windows XP 32

HP xw8400 Dual Dual
Core, 2.66 3.0MHz

Windows XP 32

NVIDIA Quadro
FX 1500 and
NVIDIA Quadro
FX 3500 and
Quadro FX 3700

HP xw4600 Core 2 Duo NVIDIA Quadro
3.0 GHz
FX570

n
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Windows Vista 64

Windows Vista 64

Windows XP 32
Windows Vista 64

Software Only
Nitris DX
Mojo DX
Adrenaline
Mojo SDI
Mojo
Matrox MX02 Mini
Software Only
Nitris DX
Mojo DX (no DNxHD capture)
Adrenaline
Mojo SDI
Mojo
Matrox MX02 Mini
Software Only
Adrenaline
Mojo DX (no DNxHD capture)
Mojo SDI
Mojo
Matrox MX02 Mini

Avid does not recommend that you connect third party devices such as Matrox MX02 Mini or
AJA Io Express and an Avid hardware device (for example, a Nitris DX, Mojo DX,
Adrenaline) to the CPU at the same time. If you do connect them at the same time, only the
Avid hardware will be recognized. The Matrox MX02 will only be recognized when the Avid
hardware is disconnected or turned off.

Qualified Hardware and Operating Systems

Qualified PC Workstations with Avid Symphony
The following PC Workstations are qualified with Avid Symphony v5.5.1 and higher.
Supported
with

Qualified PC Hardware

Graphics Card

Qualified OS

HP z800 Dual 6 Core, 2.66
GHz

NVIDIA Quadro FX
3800

Windows Vista 64-bit
Windows 7 64

Nitris DX

HP z800 Dual Quad Core,
2.93 GHz

NVIDIA Quadro FX
4800

Windows Vista 64
Windows 7 64

Nitris DX

HP xw8600

NVIDIA Quadro FX
3700

Windows Vista 64
Windows 7 64

Nitris DX

HP xw8400 Dual Quad Core,
2.33 MHz

NVIDIA Quadro FX
3500, 3700

Windows XP 32

Nitris

HP xw8400 Dual Dual Core,
2.66 MHz

NVIDIA Quadro FX
3500, 3700

Windows XP 32

Windows Vista 64
Nitris

Windows Vista 64

Qualified PC Notebooks for Avid Media Composer and Avid
NewsCutter
The following PC Notebooks are qualified with Avid Media Composer v5.5.1 and higher
and Avid NewsCutter v9.5.1 and higher. The following applies to the editing system when
running on a laptop:
•

DNxHD capture is only supported on Mojo DX and AJA Io Express on a Quad core
system with hyperthreading enabled. Nitris DX is not supported on laptops

•

Capture of 10 bit video for example, DNxHD 185x, is not supported on Mojo DX,
Matrox MX02 Mini and AJA io Express

•

Playback in full quality 10 bit mode is not supported
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Qualified PC
Notebooks

Graphics Cards Qualified OS

HP 8740w X820, X920
Quad i7 (1.73, 2.0 Ghz)

NVIDIA FX
2800M

17" 1920x1200

NVIDIA FX
3800M

HP 8540w X720, X820
Quad i7 (1.6, 1.73 Ghz)

NVIDIA FX
1800M

Windows XP 32
Software Only
Windows Vista 64-bit Mojo DX
Windows 7 64
Mojo SDI (requires PCI Express
FW800 add in card) and (Only
supported with Win 7 64 OS)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

Dell M6500 X820, X920
quad i7 (1.73, 2.0 Ghz)

NVIDIA FX
2800M

17" 1920x1200

NVIDIA FX
3800M

Windows XP 32
Software Only
Windows Vista 64-bit Mojo DX
Windows 7 64
Mojo SDI (requires PCI Express
FW800 add in card) and (Only
supported with Win 7 64 OS)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

HP 8730w Core 2 Duo
2.53, 3.06 GHz

NVIDIA FX
2700m and
NVIDIA FX
3700m

HP 8530w Core 2 Duo
2.53, 3.06 GHz

NVIDIA FX 770m Windows XP 32

Dell M6400 Core 2 Duo
2.53, 3.06 GHz

NVIDIA FX
2700m and
NVIDIA FX
3700m

15" 1920x1080
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Supported With

Windows XP 32
Software Only
Windows Vista 64-bit Mojo DX
Windows 7 64
Mojo SDI (requires PCI Express
FW800 add in card) and (Only
supported with Win 7 64 OS)
Matrox MX02 Mini
AJA Io Express (Win 7 only)

Windows XP 32

Software Only
Mojo DX (no DNxHD capture)
Windows Vista 64-bit
Mojo SDI (requires PCI Express
FW800 add in card) and (Only
supported with Vista 64 OS)
Matrox MX02 Mini
Software Only
Mojo DX (no DNxHD capture)
Windows Vista 64-bit
Mojo SDI (requires PCI Express
FW800 add in card) and (Only
supported with Vista 64 OS)
Matrox MX02 Mini
Windows XP 32
Software Only
Windows Vista 64-bit Mojo DX (no DNxHD capture)
Mojo SDI (requires PCI Express
FW800 add in card) and (Only
supported with Vista 64 OS)
Matrox MX02 Mini

Qualified Hardware and Operating Systems

Qualified PC
Notebooks

Graphics Cards Qualified OS

Supported With

NVIDIA Quadro
FX 570M

Windows XP 32

Software Only
Mojo DX (no DNxHD capture)
Mojo SDI
Matrox MX02 Mini

HP 8710W Intel® Core™ 2
Duo processor T7700 2.40
GHz
(docking station required if
using with Mojo DX or
Matrox Mini)

NVIDIA Quadro
FX 1600m

Windows XP 32

Software Only
Mojo DX (no DNxHD capture)
Mojo SDI
Mojo
Matrox MX02 Mini

Dell 6300 Intel Core 2 Duo
processor T7700 2.4 GHz

NVIDIA Quadro
FX 1600m

Windows XP 32

Software Only
Mojo DX (no DNxHD capture)
Mojo SDI
Mojo
Matrox MX02 Mini

HP 8510
Core 2 Duo
2.2GHz
(docking station required if
using with Mojo DX or
Matrox Mini)

n

Avid does not recommend that you connect third party devices such as Matrox MX02 Mini or
AJA Io Express and an Avid hardware device (for example, a Nitris DX, Mojo DX,
Adrenaline) to the CPU at the same time. If you do connect them at the same time, only the
Avid hardware will be recognized. The Matrox MX02 will only be recognized when the Avid
hardware is disconnected or turned off.

Qualified Macintosh Workstations for Avid Media Composer
The following Macintosh Workstations are qualified with the Avid Media Composer v5.5.1
and higher.
Qualified Macintosh
Hardware
Graphics Cards

Mac Pro “Westmere”
Two 2.66GHz 6-Core
Intel Xeon (12 cores)a

Qualified OS

ATI Radeon HD 5770 v10.6.7, v10.6.8,,
1GB
v10.7, 10.7.3,
10.7.5

Supported With

Software Only
Nitris DX
Adrenaline
Mojo DX
Mojo SDI
Matrox MX02 Mini
AJA Io Express
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Qualified Macintosh
Hardware
Graphics Cards

34

Qualified OS

Supported With

Mac Pro “Nehalem”
NVIDIA GeForce GT v10.6.7, v10.6.8,,
Dual 2.66 GH Quad
120
v10.7, 10.7.3,
Core Intel Xeon or Dual
10.7.5
2.93 GHz Quad Core
Intel Xeon

Software Only
Nitris DX
Adrenaline
Mojo DX
Mojo SDI
Matrox MX02 Mini
AJA Io Express

iMac 27” Display
2.8 GHz 4 GB
1066MHz

ATI Radeon HD 4850 v10.6.7, v10.6.8,,
Graphics Processor
v10.7, 10.7.3,
10.7.5

Software only

Mac Pro “Nehalem”
Dual 2.26 GHz Quad
Core Intel

NVIDIA GeForce GT v10.6.7, v10.6.8,,
120
v10., 10.7.37,
10.7.5

Software Only

Mac Pro “Harpertown”
Dual Quad Core 3.0 or
3.2 GHz

NVIDIA GeForce
8800 GT

v10.6.7, v10.6.8,,
v10.7, 10.7.3,
10.7.5

Software Only
Nitris DX
Adrenaline
Mojo DX
Mojo SDI
Mojo
Matrox MX02 Mini
AJA Io Express

Mac Pro Dual
Quad-Core 3GHz or
higher Intel processor

NVIDIA GeForce
7300 GT

v10.6.7, v10.6.8,,
v10.7, 10.7.3,
10.7.5

Software Only
Nitris DX
Adrenaline
Mojo DX
Mojo SDI
Mojo
Matrox MX02 Mini
AJA Io Express (no DNxHD
capture and limited HD playback)

Mac Pro Dual
NVIDIA GeForce
Dual-Core 2.66 GHz or 7300 GT
higher Intel processor

v10.6.7, v10.6.8,,
v10.7, 10.7.3,
10.7.5

Software Only
Nitris DX
Adrenaline
Mojo DX (no DNxHD capture)
Mojo SDI
Mojo

iMac 20” Display
2.66 GHz 4 GB RAM

v10.6.7, v10.6.8,,
v10.7, 10.7.3,
10.7.5

Software Only

GeForce 9400

Qualified Hardware and Operating Systems

Qualified Macintosh
Hardware
Graphics Cards

Qualified OS

Supported With

a. All new Mac Pro systems ship with a 64-bit kernel enabled by default. Customers must toggle to the 32-bit
kernel before running Media Composer or Symphony. Detailed instructions for toggling the Mac OS kernel to
32-bit can be found here:http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771

n

Avid does not recommend that you connect third party devices such as Matrox MX02 Mini or
AJA Io Express and an Avid hardware device (for example, a Nitris DX, Mojo DX,
Adrenaline) to the CPU at the same time. If you do connect them at the same time, only the
Avid hardware will be recognized. The Matrox MX02 will only be recognized when the Avid
hardware is disconnected or turned off.

Qualified Macintosh Workstations for Avid Symphony
The following Macintosh Workstations are qualified with the current editing applications.
Qualified
Macintosh
Hardware

Graphics Cards

Qualified OS

Supported With

Mac Pro “Westmere” ATI Radeon HD 5770 v10.6.7, v10.6.8,,
Two 2.66GHz 6-Core 1GB
v10.7, 10.7.3, 10.7.5
Intel Xeon (12 cores)a

Symphony Nitris DX

Mac Pro “Nehalem” NVIDIA GeForce GT v10.6.7, v10.6.8,,
Dual 2.66 GH Quad 120
v10.7, 10.7.3, 10.7.5
Core Intel Xeon or
Dual 2.93 GHz Quad
Core Intel Xeon

Symphony Nitris DX

Mac Pro
“Harpertown” Dual
Quad Core 3.0 or 3.2
GHz

Symphony Nitris DX

NVIDIA GeForce
8800GT

v10.6.7, v10.6.8,,
v10.7, 10.7.3, 10.7.5

a. All new Mac Pro systems ship with a 64-bit kernel enabled by default. Customers must toggle to the 32-bit kernel
before running Media Composer or Symphony. Detailed instructions for toggling the Mac OS kernel to 32-bit can be
found here::http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
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Qualified Macintosh Notebooks for Media Composer
The following Macintosh notebooks are qualified with the current editing applications. The
following applies to the editing system when running on a laptop.
•

HD Capture on Macintosh notebooks is not supported

•

Playback in full quality 10 bit mode is not supported

Qualified Macintosh
Notebook

Graphics Cards

Qualified OS

Supported With

13” MacBook Air
1.7GHz Dual-Core Intel Core i5
or
1.8GHz Dual-Core Intel Core i7
4GB Memory, 256GB flash
storage

Intel HD Graphics
3000

v10.7, 10.7.3,
10.7.5

Software Only

17" 2.66GHz Intel Core i7
4GB 1066MHz DDR3 SDRAM
500GB Serial ATA Drive @7200
RPM

NVidia GeForce GT
330M Graphics

v10.6.7, v10.6.8,, Software Only
v10.7, 10.7.3,
Mojo DX (no DNxHD capture)
10.7.5
Mojo SDI
Matrox MX02 Mini
AJA Io Express (Only limited
HD playback is supported.)

15" 2.66GHz Intel Core i7
4GB 1066MHz DDR3 SDRAM
500GB Serial ATA Drive @7200
RPM

NVidia GeForce GT
330M Graphics

v10.6.7, v10.6.8,, Software Only
v10.7, 10.7.3,
Mojo SDI
10.7.5

15" 2.53GHz Intel Core i7
4GB 1066MHz DDR3 SDRAM
500GB Serial ATA Drive @7200
RPM

NVidia GeForce GT
330M Graphics

v10.6.7, v10.6.8,, Software Only
v10.7, 10.7.3,
Mojo SDI
10.7.5

MacBook Pro 2.66 GHz Intel
Core 2 Duo processor, 17”
display, 4GB 1066MHz DDR3,
250GB ATA 7200 rpm drive

NVIDIA GeForce
9400M and 9600M
GT

v10.6.7, v10.6.8,, Software Only
v10.7, 10.7.3,
Mojo DX (no DNxHD capture)
10.7.5
Mojo SDI
Matrox MX02 Mini
AJA Io Express (Only limited
HD playback is supported.)

MacBook Pro 2.53 GHz Intel
Core 2 Duo processor, 15”
display, 4GB 1066MHz DDR3,
250GB ATA 7200 rpm drive

NVIDIA GeForce
9400M and 9600M
GT

v10.6.7, v10.6.8,, Software Only
v10.7, 10.7.3,
Mojo DX (no DNxHD capture)
10.7.5
Mojo SDI
Matrox MX02 Mini
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Required Hotfix Info

Qualified Macintosh
Notebook

Graphics Cards

Qualified OS

Supported With

MacBook Pro 2.5 GHz Intel Core NVIDIA GeForce FX v10.6.7, v10.6.8,, Software Only
2 Duo processor, 15” & 17”
8600m GT graphics v10.7, 10.7.3,
Mojo DX (no DNxHD capture)
Display
with 256MB SDRAM 10.7.5
Mojo SDI
Matrox MX02 Mini
MacBook Pro 2.4 GHz Intel Core NVIDIA GeForce FX v10.6.7, v10.6.8,, Software Only
2 Duo processor, 15” & 17”
8600m GT graphics v10.7, 10.7.3,
Mojo DX (no DNxHD capture)
Display
with 256MB SDRAM 10.7.5
Mojo SDI
Matrox MX02 Mini
MacBook Pro 2.53GHz Intel Core NVidia GeForce
i5 15” display 4GB 1066MHz
330M GT graphics
DDR3 SDRAM 500GB Serial
ATA Drive @7200 RPM

n

v10.6.7, v10.6.8,, Software Only
v10.7, 10.7.3,
Mojo SDI
10.7.5

Avid does not recommend that you connect the Matrox MX02 Mini device and an Avid
supported hardware device (for example, a Nitris DX, Mojo DX, Adrenaline) to the CPU at
the same time. If you do connect them at the same time, only the Avid hardware will be
recognized. The Matrox MX02 will only be recognized when the Avid hardware is
disconnected or turned off.

Required Hotfix Info
If you have an HP z800 or HP z400 system and are running Windows XP 32 OS, you must
install a Microsoft WinXP32 SP3 hotfix in order for the supported OHCI card to function
properly with Avid DNA hardware. Download the Hotfix from the following location.
http://support.microsoft.com/hotfix/KBHotfix.aspx?kbnum=955408&kbln=en-us
The hotfix page indicates that this fix is for SP4. The fix is actually for SP3. It is safe to take
this fix for SP3.
Restart your system after running the hotfix.

37

Compatibility Chart
The following table lists the operating system, NVIDIA® driver, QuickTime®, Windows
Media™, Avid Interplay®, shared storage, Sony® XDCAM™, Panasonic® P2, and Pro Tools
LE® versions that were qualified with the Avid editing applications. Also listed are the
third-party applications such as Boris Continuum Complete, Avid DVD by Sonic™,
Sorenson Squeeze®, and SmartSound® that ship with the editing applications.
Item

Versions

QuickTime Support v7.6.9 (Windows)
v10 X (Snow Leopard)
v10.1 (Lion)

Note: QuickTime v10X does not include
QuickTime Pro options.

Windows Media
Version Support

If you do not have Windows Media
Player, access the download at
www.microsoft.com.

Windows Media Player 12 (for
Windows 7)
Windows Media Player 11 (for
Windows Vista or Windows XP)

Avid Interplay
Support
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Comments

See the Avid Interplay ReadMe
for supported versions.

Windows Media export compatibility is
subject to Microsoft Windows Media
updates.
IMPORTANT: The Avid Interplay
components that get installed on the
editing application must be updated to
the Avid Interplay version that is released
with the editing application. These
include the Media Indexer, Interplay
Access, Interplay Framework, Interplay
Transfer Client and ProEncode Client.
The Avid Interplay Server components
can remain on the previous releases listed
as supported. For details, see the “Avid
Editing Application Compatibility with
Interplay Releases” topic in the Avid
Interplay ReadMe.

Compatibility Chart

Item

Versions

Comments

NVIDIA Driver
Support

v190.38

See “Setting up the NVIDIA Card” on
page 47.

v259.77 - for use only with the
following Win 7, Vista 64
systems:

Shared Storage
Support
Pro Tools

•

z800 Gen 2 (with 3800
graphics card)

•

z800 Gen 1 (with 4800
graphics card)

•

z400 Gen 2 (with 3800
graphics card)

Avid Unity™ MediaNetwork and
Avid Unity ISIS®.

See “Shared Storage Support” on
page 49.
•

For information on supported
versions of Pro Tools in an Interplay
environment, see the Avid Interplay
ReadMe or
http://avid.custkb.com/avid/app/selfs
ervice/search.jsp?DocId=353977&Hi
lite=Pro+Tools+Interplay

•

For Co-install information, see “Avid
Editing Application Compatibility
with Pro Tools” on page 41.

•

For Video Satellite information, see
the Video Satellite Guide or
http://avid.custkb.com/avid/app/selfs
ervice/search.jsp?DocId=354337&Hi
lite=video+satellite
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Item

Versions

Comments

Sony XDCAM
driver

WinXP 32 – FAM 2.1, PDZ 2.50

Avid recommends you install the Pro
Disc 2.04 driver on the Windows XP
system running SP3 when using the
following Sony PDW devices:
PDW 1500, PDW HD1500, PDW 700,
PDW 350, PDW F75, PDW F70, PDW
D1. The driver can be downloaded from
Sony's website http://esupport.sony.com/.

Vista 64 – FAM 2.2, PDZ 2.50
v2.10 (XDCAM Transfer for
Macintosh)
Win 7-64 FAM 2.3.0 and VFAM
2.3.2

Avid recommends you install the VFAM
driver v2.2 (WinXP 32) or the VFAM
2.3.2 (Macintosh OS) when using the
PDWU1 device. The firmware version is
2.45. The driver can be downloaded from
Sony's website http://esupport.sony.com/.
Panasonic P2 driver (Windows XP and Vista) Driver
version for P2 devices: v2.09

There is currently no P2 writeback
support for Macintosh clients.

(Macintosh) Driver version for P2
devices: v1.33
(Windows 7) Driver version for
P2 devices:v2.12
Boris Continuum
Complete

40

v7.0.1

Ships with:
Avid Media Composer
Avid NewsCutter®
Avid Symphony™ Nitris®
Avid Symphony Nitris DX

Avid DVD by Sonic v6.1.1

Ships with:
Avid Media Composer
Avid NewsCutter
Avid Symphony Nitris
Avid Symphony Nitris DX

Sorenson Squeeze

Ships with:
Avid Media Composer
Avid NewsCutter
Avid Symphony Nitris
Avid Symphony Nitris DX

v6.0.4

Avid Editing Application Compatibility with Pro Tools

Item

Versions

Comments

SmartSound
Sonicfire® Pro

v5.5.2

Ships with:
Avid Media Composer
Avid NewsCutter
Avid Symphony Nitris
Avid Symphony Nitris DX

Avid FX

v5.8.3

Ships with:
Avid Media Composer
Avid NewsCutter
Avid Symphony Nitris
Avid Symphony Nitris DX

Matrox Drivers

The Matrox drivers are not
included with the editing
application.
Please visit the Matrox web site
for the latest Avid certified
drivers.
www.matrox.com

AJA Io Express

The AJA drivers are not included
with the editing application.
Please visit the AJA web site for
the drivers.
http://www.aja.com/support/io/ioexpress.php

Avid Artist Series
(Euphonix)

EuControl software v2.5.7 or later

Avid Editing Application Compatibility with
Pro Tools
When you install Avid editing applications and Avid Pro Tools on the same system, note the
following:
•

If you install both an Avid editing application and Pro Tools on the same system, you
cannot run both applications at the same time.

•

To install Pro Tools and an Avid editing application on the same system, install Pro
Tools first and then the editing application.
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•

Pro Tools v8.5 and later is not supported on Windows Vista (32-bit) and Windows XP.
Co-installation is not qualified with these operating systems.

•

When you uninstall Pro Tools, choose to uninstall just the application and not the audio
drivers or the editing application no longer sees the devices. On a Macintosh Pro Tools
system, this is named the “Safe Uninstall.” On a Windows Pro Tools system, you must
select the first uninstall option — “Pro Tools Only” — which is not selected by default.

•

(Macintosh only) When you uninstall your Avid editing application, you must uninstall
just the application and not the audio drivers or Pro Tools no longer sees the devices.
When you start the Avid Uninstaller, deselect the options to uninstall
AvidCoreRuntime.pkg and AvidDIORuntime.pkg.

•

If you install and configure Avid Mojo DX or Nitris DX hardware on your system, the
editing application does not use any connected Pro Tools audio device for audio
input/output operations. If you install and configure Avid Mojo SDI and Adrenaline
hardware on your system, you can use supported audio devices when you work in 1394
mode. You can also use these audio devices with a software-only version of your Avid
editing application (Media Composer and NewsCutter).

•

If you run into any issues, uninstall both applications and reinstall Pro Tools first, and
then reinstall your editing application.

•

If you want to install your Avid editing application on a system with the Pro Tools Avid
Video Engine installed, you must use one of the following configurations:

•

-

Media Composer v5.5/NewsCutter v9.5 and later with Pro Tools v9.0 or later.

-

Media Composer v5.0.x/NewsCutter v9.0.x with Pro Tools v8.5 or earlier.

Media Composer v5.0 and later and Pro Tools v8.0.3 and later do not include support
for the Original Mbox. If you want to use the Original Mbox, you should use Media
Composer v4.x and Pro Tools v8.0.1 instead.

Co-installation Configurations and Audio Device
Support
The following tables provide a list of Avid editing applications supported with Pro Tools
peripherals. This includes supported Pro Tools audio devices that you can use for
input/output operations. This support information applies to the following versions:
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•

Avid Media Composer v5.5 and later (MC)

•

Avid Symphony v5.5 and later

•

Avid NewsCutter v9.5 and later (NC)

Co-installation Configurations and Audio Device Support

n

See “Avid Editing Application Compatibility with Pro Tools” on page 41 for information on
support for specific operating systems with Pro Tools.
The reference tables use the following terms to describe co-installation and support for audio
devices:
•

Co-install — Indicates that you can install the device on the same system as you install
your Avid editing application. Not all devices supported for co-install can be used as
external audio devices with your Avid editing application.

•

Audio Device — Indicates that you can use the audio device for input and output
operations with your Avid editing application. Some audio devices might not support all
input/output functionality.

•

Audio Device (1394 only) — Indicates that you can use the audio device for input and
output operations only when you select 1394 in your Avid editing application. For
information on using the DNA/1394 button, see “Selecting a DV Device” in the Help.

•

Not supported — Indicates that you cannot use the audio device for input/output
operations with the Avid editing system.

•

Not Tested — Indicates that Avid has not tested the device with a supported Avid
editing system configuration.

Avid Pro Tools Applications
MC/NC
Software
Only

MC/NC
with Mojo
SDI

MC/NC
MC/NC with with Mojo
Adrenaline DX

MC/NC/
MC/NC with
Symphony
Matrox
with Nitris DX MX02 Mini

Pro Tools
Software Only

Co-install

Co-install

Co-install

Co-install

Co-install

Co-install

Pro Tools|HD
Native

Co-install/
Co-install/
Not Tested
Audio Device Audio Device
(1394 only)

Co-install

Co-install

Co-install/
Audio Device
(1394 only)

Pro Tools|HD

Co-install/
Co-install/
Co-install
Audio Device Audio Device
(1394 only)

Co-install

Co-install

Co-install/
Audio Device
(1394 only)

Pro Tools|HD,
with chassis

Not Tested

Not Tested

Not Tested

Not Tested

Pro Tools
Product

Not Tested

Not Tested
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Avid Mbox Family Audio Devices (3rd Generation)
Audio
MC/NC
Device
Software
(Interface) Only

MC/NC with MC/NC with MC/NC with
Mojo SDI
Adrenaline Mojo DX

MC/NC/
MC/NC with
Symphony
Matrox
with Nitris DX MX02 Mini

Mbox
(USB)

Co-install/
Co-install/
Not Tested
Audio Device Audio Device
(1394 only)

Co-install

Co-install

Co-install/
Audio Device
(1394 only)

Mbox Pro

Co-install/
Co-install/
Not tested
Audio Device Audio Device
(1394 only)

Co-install

Co-install

Co-install/
Audio Device
(1394 only)

Mbox Mini
(USB)

Co-install/
Co-install/
Not Tested
Audio Device Audio Device
(1394 only)

Co-install

Co-install

Co-install/
Audio Device
(1394 only)

Avid Mbox 2 Family Audio Devices
Audio
MC/NC
Device
Software
(Interface) Only

Mbox 2
(USB)

MC/NC with MC/NC with MC/NC with
Mojo SDI
Adrenaline Mojo DX

Co-install/
Co-install/
Co-install/
Co-install
Audio Device Audio Device Audio Device
(1394 only)
(1394 only)

MC/NC/
MC/NC with
Symphony
Matrox
with Nitris DX MX02 Mini

Co-install

Co-install/
Audio Device
(1394 only)

Not Supported Not Supported Co-install

Co-install

Co-install

Mbox 2
Co-install/
Co-install/
Co-install/
Co-install
Mini (USB) Audio Device Audio Device Audio Device
(1394 only)
(1394 only)

Co-install

Co-install/
Audio Device
(1394 only)

Mbox 2
Micro
(USB)

Not tested

Co-install

Mbox 2 Pro Co-install
(1394)
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Co-install

Co-install

Not Tested

Co-install

External Controllers

Other Avid Audio Devices
Audio
MC/NC
Device
Software
(Interface) Only

MC/NC with MC/NC with MC/NC with
Mojo SDI
Adrenaline Mojo DX

MC/NC/
MC/NC with
Symphony
Matrox
with Nitris DX MX02 Mini

Digi 002
(1394)

Co-install/
Co-install/
Co-install/
Co-install
Audio Device Audio Device Audio Device
(Windows)
(Windows)
(Windows)

Co-install

Co-install/
Audio Device
(Windows,
1394 only)

Digi 003
(1394)

Co-install

Co-install

Co-install

Eleven Rack Not Supported Not Supported Not Supported Not Supported
(USB)

Not Supported

Not Supported

Fast Track
Pro (USB)

Not Supported

Audio Device
(1394 only)

Co-install

Co-install

Co-install

Audio Device Audio Device Audio Device Not Supported
(1394 only)
(1394 only)

External Controllers
Your Avid editing application supports the following external fader controllers or mixers for
automation gain and pan recording or as control surfaces:

n

•

Digi 002 (Windows only — Media Composer and NewsCutter)

•

Command|8

•

Avid Artist Control

•

Avid Artist Mix

•

Avid Artist Transport

•

JL Cooper MCS-3000X MIDI automation controller

•

JL Cooper FaderMaster Pro MIDI automation controller

•

Yamaha® 01V/96 and Yamaha 01V digital mixing console

The JL Cooper controllers and Yamaha mixing consoles do not support automation pan
recording.
External controllers or mixers are optional. They are not required for you to perform
automation gain or pan recording on an Avid editing system.
The following table compares Avid external controllers and mixers.
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Avid Artist Avid Artist
Digi 002 (MC/NC only) Command|8 Control
Mix

Feature

Avid Artist
Transport

Control surface for Yes
transport controls
and other
functions

Yes

Yes

Yes (transport Yes
only, no soft
keys)

Provides audio
play, input, and
output

Yes

No

No

No

No

Record automation Yes
gain

Yes

Yes

Yes

No

Record automation Yes
pan

Yes

Yes

Yes

No

Flying faders

Yes (8)

Yes (8)

Yes (4)

Yes (8)

No

Touch-sensitive
faders

Yes

Yes

Yes

Yes

No

Touch-sensitive
panners

No

No

Yes

Yes

No

Solo/mute

Yes

Yes

Yes

Yes

No

Supports audio
mixing

Noa

No

No

No

No

Latch mode (also
known as Snap
mode)

Yes

Yes

Yes

Yes

No

1024

1024

1024

Not applicable

Number of steps of 1024
fader accuracy

a. The Digi 002 can be used as a standalone audio mixer but not at the same time as it is being used as an automation gain
or automation pan controller or control surface.

The following table compares supported third-party external controllers and mixers.
Feature

FaderMaster Pro

MCS-3000X

Yamaha 01V/96 and Yamaha 01V

Control surface for transport
controls and other functions

No

No

No
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Setting up the NVIDIA Card

Feature

FaderMaster Pro

MCS-3000X

Yamaha 01V/96 and Yamaha 01V

Provides audio play, input, and No
output

No

No

Record automation gain

Yes

Yes

Yes

Record automation pan

No

No

No

Flying faders

No

Yes

Yes

Touch-sensitive faders

No

Yes

No

Solo/mute

Yes

Yes

Yesa

Supports audio mixing

No

No

Yes

Latch mode (also known as
Snap mode)

No

Yes

No

Number of fader steps of
accuracy

128

1024

256

a. For Yamaha fader/controllers, solo works only if you do not use the unit for audio mixing at the same time

For more information on using these external fader controllers or mixers, see “Recording
Automation Gain or Automation Pan Information” in the Help.

Setting up the NVIDIA Card
To set up the NVIDIA card, you must make sure you have the correct display driver version,
install the display driver if necessary, and set the correct display settings. This version of the
editing application requires the following:
Prior to setting up the NVIDIA card, check to make sure you have the correct display driver
version. If you do not have the correct NVIDIA driver, you can install it from the Utilities
folder that installs with your Avid application.
Which driver is required depends on the version of the NVIDIA card and the type of
operating system. Installation files for these drivers are installed in the folder Program
Files\Avid\Utilities\nVidia.
To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the
Windows Control Panel and double-click the NVIDIA Control Panel icon.
2. Click System Information at the bottom left corner of the NVIDIA Control Panel.
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The version number is listed in the Graphics card information section on the ForceWare
version line.
To install the NVIDIA display driver (Windows XP, Windows Vista, Windows 7):

1. Navigate to Program Files\Avid \ Utilities \nVidia and double-click the folder that
corresponds to your operating system.
2. Double-click the file for the applicable driver.
3. Follow the on-screen instructions, and then restart your system.
To setup multiple displays (Windows XP):

1. Right-click the Desktop, and select Nvidia Control Panel.
2. In the settings window in the left of the window, click Set up multiple displays.
3. In the “Choose View display mode to use” area, select “Configure independently from
each other (Dualview).
4. Click Apply, and then click OK.
To setup multiple displays (Windows Vista, Windows 7):

1. Right-click the Desktop, and select Nvidia Control Panel.
2. In the settings window in the left of the window, click Set up multiple displays.
3. Select or deselect the desired monitors listed.
Setting the Global Settings for 3D App- Video Editing (Required if using the v259.77
Nvidia Driver)

1. Right-click the Desktop, and select Nvidia Control Panel.
2. Click Manage 3D Settings.
3. In the Global Settings tab, change Global presets to 3D App- Video Editing.
4. Click Apply.

n

48

Leave the Global Settings for 3D App to Default Global Settings if you are using Marquee
Title Tool, Avid FX or Boris Continuum Complete. Do not use the 3D App - Video Editing
setting with these applications. There is a known redraw issue. Because you cannot use the
3D App- Video Editing setting, you might see a black flash on startup in the Source/Record
monitors.

Disabling the NVIDIA Driver Helper Service (Windows XP)

Disabling the NVIDIA Driver Helper Service
(Windows XP)
The NVIDIA driver Helper Service is a background program that runs with the NVIDIA
Driver installed. This service informs you when an update to the NVIDIA Driver is
available. There have been instances where this service causes slow restarts and shutdown
with the Avid DNA hardware attached. The service also can prevent the Adobe®
Photoshop® Gamma loader from operating, which causes color correction settings not to
work properly. If this occurs, you should disable the NVIDIA Driver Helper Service.
To disable the NVIDIA Driver Helper Service:

1. Right-click My Computer.
2. Click Manage.
3. Double-click Services and Applications.
4. Double-click Services.
5. Right-click NVIDIA Display Driver or NVIDIA Driver Helper Service.
6. Click Properties.
7. Select Startup Type > Disable.
8. Click OK.
Every time you update or reload the driver, this service is enabled again.

Shared Storage Support
The editing application has been tested in a shared storage environment with the following.
Note that ISIS 7000 was previously referred to as Avid Unity ISIS.
Editing
Application
Operating
System

ISIS
5000
Client

ISIS
5000
Server

ISIS 7000
Client

ISIS 7000
Server

v3.1,
v3.2

v3.1,
v3.2

v1.10, v2.0.6,
v2.2.2

Windows 7 64-bit v3.1,
v3.2

v3.1,
v3.2

v2.2.2

Windows XP
32-bit
and
Windows Vista
Business 64-bit

MediaNetwork
Client

MediaNetwork
Server

v1.10, v2.0.6,
v2.2.2

v5.1.3

v5.1.3

v2.0.6, v2.2.2

v5.3, v5.4

v5.1.3
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Editing
Application
Operating
System

Macintosh OS
v10.6.7, 10.6.8,
v10.7, 10.7.3

ISIS
5000
Client

ISIS
5000
Server

ISIS 7000
Client

ISIS 7000
Server

v3.1,
v3.2

v3.1,
v3.2

v2.2.2 and
higher

v1.10, v2.0.6,
v2.2.2

MediaNetwork
Client

MediaNetwork
Server

v5.3.3

v5.1.3

Feature Performance
A number of features in this editing application are processor-intensive. As a result, you
might experience problems if you are working on an older system. The following chart
shows the hardware that Avid has successfully qualified when using these features.
Feature

Description

Recommended System

HD RGB

HD RGB capture requires a high •
end workstation with Nitris DX
and fast storage. (The HP z800
and the Dell T5500 have been
•
qualified to successfully play
back 2 streams with PIP and
Color Correction effects. The Mac
Pro Dual Quad Core “Nahalem” •
successfully plays back 2 streams
with PIP.)
•
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HP z800 Dual Quad Core, or
Dual 6 Core, with
Hyperthreading On - 64-bit OS
Dell T5500 Dual, 2.93GHz Quad
Core with Hyperthreading On
64-bit OS
Mac Pro Dual Quad Core
“Nahalem” or Dual 6 Core
“Westmere”
Storage: 10Gb Ethernet ISIS,
VideoRaid II SR or two
VideoRaid II ST striped together.

Feature Performance

Feature

Description

Recommended System

AVCI-Intra

AVC-Intra(AVC-I) is a high
4-Way MultiCam Playback
quality, low bit-rate HD codec and
• HP z800 Dual Quad Core or
is very CPU intensive.
Dual 6 Core, with
Hyperthreading On - 64-bit OS
•

Mac Pro Dual Quad Core
“Nahalem” or Dual 6 Core
“Westmere”

Four Stream Playback:
•

HP z800 Dual 6 Core with
Hyperthreading On - 64-bit OS

•

Mac Pro Dual 6 Core
“Westmere”

Two Stream Playback:
•

HP z400, single 6 Core with
Hyperthreading On

Single Stream Playback:
•

Systems listed above.

•

HP z400, single 4-core with
Hyperthreading On

•

HP 8600, dual 4-core without
Hyperthreading On

•

HP 8740w laptop, i7 (1.73GHz)
4-core with Hyperthreading On

•

HP 8540w laptop, i7 (1.73GHz)
4-core with Hyperthreading On

•

Dell Precision M6500 laptop, i7
(2.00 GHz) 4-core with
Hyperthreading On

•

The MacBook Pro 17" laptop, i7
(2.66 GHz) 2-core with
Hyperthreading On

•

iMac 27", i7 (2.8GHz) 4-core
with Hyperthreading On
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Feature

Description

Recommended System

XDCAM HD50 Capture

Baseband capture through Nitris
DX, Mojo DX, or AJA Io
Express. (only ones that have
successfully worked with)

•

HP z800 Dual Quad Core, or
Dual 6 Core, with
Hyperthreading On - 64-bit OS

•

HP z400, 6-core with
Hyperthreading On

•

Dell T5500 Dual, 2.93GHz Quad
Core with Hyperthreading On
64-bit OS

•

Mac Pro Dual Quad Core
“Nahalem” or Dual 6 Core
“Westmere”

•

HP z800 Dual Quad Core, or
Dual 6 Core, with
Hyperthreading On - 64-bit OS

•

HP z400, single 4-core or 6-core
with Hyperthreading On

•

Dell T5500 Dual, 2.93GHz Quad
Core with Hyperthreading On
64-bit OS

•

Mac Pro Dual Quad Core
“Nahalem” or Dual 6 Core
“Westmere”

AMA (RED)
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AMA is a processor intensive
operation. Older platforms may
not offer optimum performance.

AMA (QuickTime)

AMA is a processor intensive
operation. Lower end platforms
may not offer optimum
performance. Highly compressed
codecs such as H.264 will exhibit
minimal real-time performance.

Recommendation of qualified
systems depends on your planned
use of this feature. Heavy usage of
highly compressed codecs requires
the high end systems.

DVCPro HD capture

You will get better performance
with a dual quad core or dual
6-core system.

Dual Quad Core or dual 6-core
Systems

Limitations and Known Issues

Feature

Description

Recommended System

Ancillary Data

Ancillary Data and Nitris DX:
Dual Quad Core or dual 6-core
Due to software DNxHD codec
Systems
performance requirements, you
must have a dual quad core
system in order to capture
DNxHD 220 or 220x with
ancillary data on the Nitris DX
platform. If your system does not
meet the system requirements, the
only way to capture DNxHD 220
or 220x is to make sure that
ancillary data is not enabled.

Limitations and Known Issues
AMA (Avid Media Access)
➤

The Load button in the QuickTime Settings Source window does not apply to QuickTime
media.

➤

Bug Number: UDevC00151527. When you relink Sony HDCAM SR media, the Relink
methods: Highest Quality, Most Compressed, and Specific Resolutions do not work with an
HDCAM SR linked AMA clip.
Workaround: To relink a Sony HDCAM SR clip, select the clips in the desired quality and
the sequences to be relinked, then select the Relink option “Selected items In ALL open
bins.”

➤

Bug Number: UDevC00149406. Clips become offline after you relink a consolidated
sequence to AMA clips on a virtual volume.

➤

Bug Number: UDevC00149476. The Consolidate Preference options in the AMA Settings
Quality tab does not work with XDCAM subclips.

➤

Bug Number: UDevC00151057. If you transcode a RED subclip or a sequence that
includes a RED subclip, the transcoded media will include the source settings from the
master clip, not the source settings from the subclip.
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➤

Bug Number: UDevC00148923. When playing some old XDCAM clips, including media
that was sent out with Avid training material, a timeout error occurs due to multiple clips
having the same MOB IDs.

➤

Bug Number: . When running your Avid editing system as an ISIS client, for effective
playback of hi-resolution AMA media, you should run as a High Resolution client. The
default is set to Medium Resolution.
To set the Client Type:

1. Open the Client Manager.
2. Click the Preferences button.
3. Click General.
4. In the General area, click the Client Type menu, and select the appropriate client type:
t

Ultra High Resolution

t

High Resolution

t

Medium Resolution

t

Low Resolution

5. Click Apply
6. Click Close.
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➤

Bug Number: UDevC149203. (Macintosh only) If you “AMA Link to File” clips located
on shared storage and the AMA clips don't highlight yellow in the bin, it could be because
the AvidSharedStorageAccess.dylib file is missing. This file is located in
/Library/Application Support/Avid folder. Avid has run into a few instances where this file is
missing, but we have not been able to determine why this is happening. If you are using ISIS
or Media Net and have run into this situation, you should re-install your ISIS client to restore
this file.

➤

Bug Number: UDevC00147657. If you receive an exception error while you transcode a
RED clip, and the R3D Source Quality (Debayer) is set to Full, quit and restart the Avid
editing application, then try the transcode operation again. If the transcode still does not
succeed, choose a lower quality Debayer setting.

➤

Bug Number: UDevC00148169. Depending on the type of media, different durations might
appear when you consolidate or transcode a clip. This is due to the structure of the file. For
example, Long GOP I-Frame media adds extra frames to handles of a new master clip when
you consolidate or transcode a clip. However, non-Long GOP media, such as P2 media, does
not add extra frames to the handle when you consolidate or transcode a clip.

Limitations and Known Issues

➤

Bug Number: UDevC00149334 . When you AMA link to a QuickTime ProRes4444 movie,
there will be a 444 to 422 downsampling in a 10-bit RGB project. This downsampling
should not occur. Avid hopes to fix this for a future release.

➤

Bug Number: UDevC00140279 (Macintosh only). If you link to a QuickTime AMA clip
on the root (Macintosh HD) drive, the system displays Media Offline.
Workaround: Move the QuickTime file one level below the Macintosh HD. Create a folder
on the Macintosh HD drive and place the QuickTime file in the folder.

➤

Bug Number: UDevC00131509. QuickTime AMA media fails to link when you move bins
back and forth from a Macintosh system to a Windows system or from a Windows system to
a Macintosh.

➤

Bug Number: UDevC00142585. If you cancel an XDCAM consolidate or transcode
operation and receive an exception error, save your work and restart the Avid editing
application.

➤

Bug Number: UDevC00135303. The timecodes do not match between an XDCAM proxy
clip and an HD MXF clip shot in Picture Cache mode due to extra frames in the long GOP
material.

➤

Bug Number: UDevC00131647. Mixing down a sequence that contains clips with too
much metadata, might cause an error.

➤

Bug Number: UDevC00134558. Windows UNC (Universal Naming Convention) paths are
not supported with AMA media. To link AMA media, map it to the drive.

➤

Bug Number: UDevC00140133. With the latest VFAM Sony Drivers 2.30, if you link
XDCAM AMA clips using the Sony PDW-U1 device, the clips display offline in the bin if
you eject the disk and then reinsert the same disk.
Workaround: Quit the application and relaunch it again to relink the clips.

➤

Bug Number: UDevC00141966. You cannot link to 720p/59.94 media if you choose Most
Compressed in the AMA Resolution Quality dialog box when you attempt to Modify an
AMA Resolution.

➤

Bug Number: UDevC00141150. XDCAM clips that have a precharge offset will link with
the precharge timecode. The timecode will not be correct.

➤

Bug Number: UDevC00143001. (QuickTime AMA) Working with clips using compressed
codecs such as H.264 might not playback effects in real time.
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Workaround: Render the effects.

➤

Bug Number: UDevC00138429. If you uninstall an AMA plug-in and attempt to play a
linked clip that you linked when the AMA plug-in was installed, the clip will not play and
you will receive the error message: “Cannot access the AMA media stream plugin to play
this clip.”
Workaround: Reinstall the plug-in, or go to www.avid.com/ama to download the latest AMA
plug-ins.

➤

Bug Number: UDevC00135324. AMA GFCAM plug-ins do not support drop-frame
timecode at this time. This will be fixed in a future release.

➤

AMA and XDCAM Optical Disks: When accessing media through Avid Media Access
(AMA), system response time can be affected due to the high latency of the XDCAM optical
disk. This can affect media access response time while linking, playing back, and scrubbing.
When you create sequences with multiple effects or layered tracks, Avid suggests that you
consolidate the media to a local drive instead of working directly from the optical disk to
avoid dropped frames and to avoid slow response time.

➤

AMA and JVC: JVC SDHC volumes are not automatically detected and mounted by AMA.
Sony's AMA XDCAM-EX plug-in currently detects Sony's SxS folder structure, but does
not yet detect the JVC SDHC folder structure. A workaround is to use the “File > Link to
AMA Volume(s)” menu option and then navigate to the /PRIVATE/JVC/BPAV folder on the
SDHC card.
Avid is working with Sony to allow for the AMA XDCAM EX plug-in to automatically
detect this folder structure.
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➤

At this time, the Dynamic Relink option is not available with AMA clips.

➤

Bug Number: UDevC00119182. When you use the AMA method, additional metadata
column headings disappear when you use custom bin views. There are different scenarios
when this issue might occur.
They include: When you use the AMA method to link to media and then switch back to an
already existing custom bin view created before using the AMA feature, the additional
metadata columns disappear. We've also seen a similar situation if you create a P2 bin and
link with AMA. Create a customize bin view. All default columns and additional metadata
columns display. If you then create an XDCAM bin and link with AMA, and then create
another customized bin view. All default columns and additional metadata columns display
as well. When you switch back to the first P2 customized bin view, the additional metadata
columns disappear.

Limitations and Known Issues

Workaround: When using AMA, Avid recommends that you do not create custom bin
views. Use the default preset bin views.

➤

Bug Number: UDevC00120470, UDevC00134917. When linking clips through AMA, the
metadata information might be missing when you switch from Brief view to Text view in a
new bin.
Workaround: Link the clips through AMA when the bin is in Text, Script, or Frame view.

➤

Bug Number: UDevC00120055. The Avid editing system might be slow to respond while
mounting multiple workspaces, while in the application, in AMA (Avid Media Access).
Workaround: Mount the multiple workspaces prior to opening the Avid editing
application, and then work in AMA.

➤

Bug Number: UDevC00119615. (Macintosh only) Offline clips appear selected
(highlighted yellow) even after you eject a write-protected XDCAM EX (SxS) card.
Workaround: Do not write-protect the card and do not eject the card while the application
is running.

➤

Bug Number: UDevC00115894. Playing back XDCAM DV 25 media from a disc might
drop or skip audio frames, this could be due to the disc needing time to spin back up.

➤

Bug Number: UDevC00116263. The following folder names: “OMFI MediaFiles,” “Avid
MediaFiles,” “Contents,” “Clip,” and “BPAV” are application or camera generated file
names which contain data appropriate media files. To avoid assertion failure errors when
mounting volumes, do not create additional folders with these file names on your system.

Ancillary Data
➤

Bug Number: UDevC00141601, UDevC00140008. In order to capture the D-track in an
Interplay environment, you must turn off the “During capture, clip is updated in Interplay”
option in the Capture Settings: MXF Media Files tab. Note: It is not necessary to disable this
option when performing an edit while capture from an ingest server such as AirSpeed.

➤

Bug Number: UDevC00142494. The D-Track monitor button in the Timeline's Track
Selector panel does not automatically turn on and off depending on the editing mode you are
in. For example, if you switch to Legacy mode in the Media Creation Capture tab, you need
to manually click the D-track Record button to turn it off for playback.
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➤

Bug Number: UDevC00142728. Transferring a clip with ancillary data (data track) from an
Airspeed Multi Stream system to ISIS might cause an assertion error. This does not affect
the playback of the clip in the Avid editing application.

➤

Bug Number: UDevC00141912. Moving sequences with an ancillary data track to an older
version of the Avid editing application and then back is not recommended.
The D-track is removed when you move a sequence with a data track from an earlier version
of the Avid editing application to this version (v5.0/v9.0).

➤

Bug Number: UDevC00132039. (Nitris DX and Mojo DX) You cannot output HD
ancillary data if down convert is enabled.

Audio
➤

Bug Number: UDevC00148843. (Macintosh only) If you change your Controller Settings
when you have an MCS-3000X controller connected to your system, the controller might
become unresponsive. This can happen if you disconnect and connect to the MCS-3000X or
if you change the controller key mappings while your Avid editing application is running.
Workaround: In the Controller Settings dialog box, click the Gain Controller Port menu
select “no port,” and then click OK. Then turn off the MCS-3000X controller and turn it on
again. In the Controllers Settings dialog box, click the Gain Controller Port menu select port
that corresponds to the MCS-3000X, and then click OK. The MCS-3000X controller now
responds as expected.

➤

Bug Number: UDevC00148675. (Macintosh only) If you connect an Avid Artist Series
controller to you system, your Avid editing application might crash if you try to work with
your application after your system has gone to sleep.
Workaround: Avid recommends that you set your operating system preferences to never
go to sleep. In System Preferences > Hardware Energy Saver, select Never.

➤

Bug Number: UDevC00147787. If you try to use an Avid Artist Series controller with a
version of the EuControl software earlier than v2.5.7, your Avid editing application might
stop working. Avid Media Composer v5.5, Avid Symphony v5.5, and Avid NewsCutter v9.5
support EuControl v2.5.7 and later.
Workaround: Download and install the latest version of the EuControl software from
www.avid.com.
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Limitations and Known Issues

➤

Bug Number: UDevC00147446. If you enable mouse jog or mouse shuttle in your Avid
editing application, you might not be able to use the jog wheel and shuttle ring on your Avid
Artist Series controller. If you want to use the controller to jog and shuttle through footage,
disable mouse jog and shuttle in your editing application before using your controller.

➤

Bug Number: UDevC00147445. If you try to access a system running the EuControl
software through a Virtual Private Network (VPN), EuControl cannot recognize
workstations or control surfaces connected to the network if EuControl is running on a
system different from the ones to which the controllers are connected.

➤

Bug Number: UDevC00143160. In a 1080p 23.976 project, the Record monitor might
display frames slightly earlier than the client monitor when playing media with audio at
faster than 3x speed. When you stop playback, the Record monitor jumps to the frame
displayed in the client monitor.
Workaround: You can either disable audio tracks before playing your media or play media
back at 3x speed or slower.

➤

Bug Number: UDevC00142918. You cannot convert a sequence that contains multichannel
audio tracks to another format. For example, if you have a 1080i/59.94 sequence with
multichannel audio, you cannot convert it to a 720p/29.97 format even though the new
format has the same frame rate.
Workaround: You can split all multichannel audio tracks to mono and then convert the
format of the sequence. Note that splitting tracks to mono modifies some audio properties —
for example, it removes stereo track effects. For more information, see “Splitting Stereo
Tracks to Mono Tracks” in the Help.

➤

Bug Number: UDevC00138422. Some unsupported audio plug-ins might appear available
on the RTAS menu. If you select one of these plugins from the RTAS menu, it might result in
a crash. To eliminate this possible condition, please remove the following from:
(XP): Program Files\<Common Files>\Digidesign\DAE\Plug-Ins folder: 1-Band EQ II
(mono), 4-Band EQ II (mono), Compressor (mono), DeEsser (mono), Expander-Gate
(mono), Gate (mono), Limiter (mono).
(Windows 7/Vista): Program Files(x86)\<Common Files>\Digidesign\DAE\Plug-Ins
folder: 1-Band EQ II (mono), 4-Band EQ II (mono), Compressor (mono), DeEsser (mono),
Expander-Gate (mono), Gate (mono), Limiter (mono).

➤

Bug Number: UDEV00220668. If your system is an HP xw8400, you must customize the
sound configuration in order for the editing application to correctly control the levels of the
microphone or other connected audio device:
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Workaround: To customize the sound card configuration:
1. In the Project window, click the Settings tab.
2. Double-click Sound Card Configuration.
3. Ensure that the Record/Input descriptions match the Playback/Output settings. For
example, if you have a microphone plugged into the rear pink connector, then the
Playback/Output option should be set to Rear Pink In. If you have a Line input audio
device connected to the front black connector, the Playback/Output option should be set
to Front Black In.

➤

Bug Number: UDEV00143962. Clip Pan: When you add an audio dissolve between two
clips with Clip Pan onto a single audio track, the audio dissolve uses the Clip Pan setting on
the outgoing source for the duration of the dissolve.

➤

Bug Number: UDevC00118578. Occasionally, you might receive a “ReadStreamAsyn”
error when performing a Digital Audio Scrub. If you continue scrubbing, the audio will
come back.

➤

Bug Number: . Pan Automation (overrides Clip Pan when applied): When you add an audio
dissolve between two clips with Automation Pan onto a single audio track, the audio
dissolve interpolates the pan values between the pan keyframe value at the beginning of the
dissolve and the pan keyframe value at the end of the dissolve. Any pan keyframe that exists
in the middle of the dissolve is ignored.
Workaround: Place the two clips on separate tracks using Clip Pan, fade one to silence,
and fade the other up from silence.

➤

Bug Number: . The following procedure causes a failure in the audio output: Open a
720p50 HD project, open the Capture tool and select HD-SDI video and Audio input.
Capture an HD Clip from Satellite source using HD-SDI Embedded feature and save it to a
Bin. Create an HD sequence using the above saved HD clip. Configure the Panasonic HD
150, and set the deck to accept HD-SDI audio Embedded. Open the Video output dialog.
Turn on HD-SDI Audio Embedded. Attempting to output an HD sequence (Preview) to an
HD deck using HD-SDI audio Embedded feature completely fails. There is no audio output
signal seen on Deck.

➤

Bug Number: UDEV00207753. The Panasonic HD150 deck will not decode the HD
embedded audio stream from Adrenaline or Avid Nitris.
Workaround: Connect AES audio from the Avid DNA hardware to the deck and disable
the embedded audio.
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Limitations and Known Issues

Audio Punch-In Tool
➤

Bug Number: UDEV00086862. You could monitor input during preroll in previous
versions. If you have a software-only system, you can still monitor input during preroll. If
you have an Avid Mojo, input monitoring begins at the IN point, not during preroll.

Avid Artist Series Controllers
➤

Bug Number: UDevC00150062. Some systems might experience intermittent loss of
connectivity to the Avid Artist Series controller.
Workaround: If you lose the connection to your controller, disconnect the controller using
the Controller Settings dialog box, close your Avid editing application, and turn off your
controller. Then restart the controller, the application, and reconnect the device to the
application.

➤

Bug Number: UDevC00157666. When running your editing application in Software Only
mode, if you have a DV device connected, the jog/shuttle on the Avid Artist controller will
not work smoothly. To use the controller, disconnect your DV device.

➤

Bug Number: UDevC00151526. If you disable and then enable your Avid Artist Series
controller while the Shift key is locked on the controller, the EuControl application might
stop working.
Workaround: If EuControl stops working unexpectedly, disconnect the controller using
the Controller Settings dialog box, close your Avid editing application, and turn off your
controller. Then restart the controller, the application, and reconnect the device to the
application.

➤

Bug Number: UDevC00151829. On the Avid Artist Transport, the Horizontal Zoom and
Vertical Zoom soft keys do not perform the zoom operations. Instead, the soft keys allow
you to perform a slip trim left and slip trim right, respectively.

➤

Bug Number: UDevC00152056. If you use the Jog wheel on your Avid Artist controller to
move through footage while playing multicamera clips, playback might be slower than
real-time.
Workaround: Use Mouse Jog or Shuttle in your Avid editing application or use the shuttle
control on your Avid Artist controller to move through footage faster.

➤

Bug Number: UDevC00152060. When you use the jog wheel on the Avid Artist Control to
shuttle through footage (press the Shift key, and then press the Jog key to enable shuttle), the
shuttle speed does not reset to zero when you stop playback.
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Workaround: Disable shuttle by pressing the Shift key and the Jog key, and then enable
shuttle again.

➤

Bug Number: UDevC00152126. If you use the EuControl settings to set the Avid Artist
Transport soft key to enter Trim mode and the jog wheel to perform a trim, you might exit
Trim mode, or you might be unable to trim using the jog wheel.

➤

Bug Number: UDevC00152128. If you save any changes made to the soft key assignment
for the shuttle ring on Avid Artist Transport, the shuttle ring might not perform as expected.
Workaround: Use the Revert button to undo the change.

➤

Bug Number: UDevC00149759. If you use the Workstation/Application key on your Avid
Artist Control or Avid Artist Transport to switch workstations, the EuControl application
might not switch the application sets correctly.
Workaround: In the Controller settings for your Avid editing application, deselect
EUCON controller and then select it again.

➤

Bug Number: UDevC00151772. If your sequence uses a large number of tracks, you might
notice slow performance when you repeatedly switch between the Source and Record
monitors when using your Avid Artist controller.

➤

Bug Number: UDevC00148566. (Macintosh only) When you set your Avid editing
application to use the EUCON Controller in the Controller Settings dialog box, the Gain
Controller Port remains selectable. Users should not change the Gain Controller Port option
when enabling the EUCON Controller.

➤

Bug Number: UDevC00149484. If you record automation gain, and then record automation
a second time over the same segment using your Avid Artist controller while in Touch mode,
the resulting automation might include unexpected audio keyframes. The problem is
intermittent.
Workaround: Set In and Out marks around the part of the sequence with the incorrect
keyframes. Click the Audio Mixer Tool fast menu button and select Remove Automation
Pan on Track. Then record the automation again.

➤

Bug Number: UDevC00152264. If you place the position indicator over an audio keyframe
and the faders in the Audio Mixer tool are between two audio gain values displayed in the
tool, you might see continuous small gain oscillations and refreshing of the Timeline.
Workaround: Move the slider to a different value. Although the display behaves
unexpectedly, no data corruption occurs.
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➤

Bug Number: UDevC00151581. The default sensitivity of the Jog wheel on the Avid Artist
Transport is set too high. This can result in difficulty in jogging through footage with
precision.
Workaround: Set the Jog wheel sensitivity to 25% in the General tab of the EuControl
application. For more information, see the documentation that came with your Avid Artist
Transport.

➤

Bug Number: UDevC00149497. If you use your Avid Artist controller to open the Avid
Calculator and then try to play a clip or sequence, the Calculator maintains focus for the
application and the footage does not play.
Workaround: Close the Avid Calculator before playing the clip or sequence.

➤

Bug Number: UDevC00149507. Auto-patching tracks does not work if you use the Sel key
on your Avid Artist controller to select Timeline tracks.
Workaround: Select Timeline tracks from within your Avid editing application for
auto-patching — for example, by using the mouse pointer or the keyboard shortcut to select
tracks.

➤

Bug Number: UDevC00149630. If you use the Rec and Stop keys on your Avid Artist
controller to record automation gain or pan, you might need to press the Stop key more than
once before you can start recording automation.

Avid License Control
➤

If you have already registered your Avid editing application, you do not need to register
PhraseFind or ScriptSync.

➤

The Avid License Control tool opens automatically after you install PhraseFind or
ScriptSync, however you can also open this tool from the following locations:
(Windows) Start/All Programs/Utilities/AvidLicenseControl
(Windows 7) Start/All Programs/Avid/Utilities/AvidLicenseControl
(Macintosh) Applications/Utilities/Avid Utilities/AvidLicenseControl

➤

Each language pack you purchase for PhraseFind has a specific serial number associated
with it. You cannot activate one language and then use the same serial number to activate
another language. If you want to enable two different languages, you need to purchase two
different serial numbers.
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➤

If you need to deactivate PhraseFind, you need to also uninstall PhraseFind. To deactivate
PhraseFind, use the Avid License Control application. To uninstall PhraseFind, on a
Macintosh system, manually uninstall PhraseFind. On a Windows system, use the
Add/Remove program.

Avid Unity
➤

Bug Number: UDevCC00080420. Avid Unity MediaNetwork and Power User login: If you
log into your Windows system as a Power User and use the same login in the Connection
Manager to log onto Avid Unity MediaNetwork, you cannot play media.
Workaround: In order to use an Avid editing application in Interplay you must log in as a
Power User. However, do not use the same login when you use the Connection Manager to
log onto Avid Unity MediaNetwork. Use a different login for the Connection Manager. This
problem does not exist on Avid Unity ISIS.

➤

Bug Number: UDevC00089671. Workspace names in Asian characters might appear
truncated at the end in any drive-selection list.
Workaround: Use no more than 5 characters for workspace names.

➤

Bug Number: UDEVC00089275. Changing Users on MediaNetwork Fibre attached
clients: When you change users on a fibre attached client, do not use the Switch User
function in the Windows Log Off dialog box. When you log back in as the original user you
may get the following errors when you play media: “Exception: FILE_OTHER, filename…
Exception: SYS_ERROR, status:1317, msg:The specified user does not exist.”
Workaround: To fix the problem once it occurs, reboot the system. To avoid the problem,
before you switch users, log off completely and reboot the system.

Capture
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➤

Bug Number: UDevC00135244. The Sony HDW-D1800 and HDW-D2000 decks use the
same device ID. If you autoconfigure the deck, it might not choose the correct deck. If you
encounter a problem autoconfiguring one of these decks, delete the machine template for the
deck you do not use.

➤

Bug Number: UDevC00142671. (Macintosh only) At this time, we do not support the
Addenda RS-USB/4 (USB to RS422) serial adapter.

➤

Bug Number: UDevC00117699. When performing captures over FireWire with the
SonyZ7U or Canon XH-G1 camera, you might receive “Lack of progress” errors.

Limitations and Known Issues

➤

Bug Number: UDevC00094480. If you have problems with batch capture accuracy for
footage captured over 1394 due to undetected small timecode breaks, select the “Enable
detection of small timecode break” option located in the Capture Settings DV& HDV tab.

➤

Bug Number: UDevC00116442. A 1:1 10-bit capture might fail with
DIG_VDM_OVERRUN or video overrun errors. This might not occur if storage
performance is optimized.

➤

Bug Number: UDevC00080115. (Macintosh) You might receive a “Mac Error - 37” error
when accessing a target drive or workspace with 28 or more characters.
Workaround: Make sure the target drive or workspace names have fewer than 28
characters.

➤

Bug Number: UdevC00025851, UdevC00049993. If you capture clips with an Avid editing
system on two or more days and use the same project and the same tape name (for example,
if you capture on two separate days from a cable feed named “Live”), relinking the clips
might cause the old clips to relink to the new clips. Because the clips in this instance are
captured on different days but use the same 24-hour timecode and have the same tape name,
the Avid system treats the captured material as coming from the same source. When you
relink the clips, they relink incorrectly.
Workaround: Avid recommends that you avoid using generic or nondescriptive tape names
— for example, do not use the tape name “Live” for a live feed. Instead, use distinctive tape
names for each capture. Also, you can use separate projects when capturing with your
editing system. When you change projects, even if you use the same tape name for your
captures the Avid system generates new source IDs. This prevents the relink problem.

➤

Bug Number: UDEV00225379. The editing application does not warn you if you try to
send a Frame Chase editing clip to Media Services Transcode. Do not send ingesting clips to
Media Services Transcode. Wait until the clip is completely ingested.

➤

Bug Number: UDEV00195662. When you are capturing and using the passthrough
monitor, desktop passthrough might cover error messages that are in the same space as the
passthrough monitor, preventing you from being able to read them.
Workaround: Move the affected window or message box away from the Record monitor,
put another application in front of the Avid application, and then go back to Avid to force the
UI to refresh.

➤

Bug Number: UDEV00220761. When you capture from an HDV device through 1394 into
an HDV interlaced project, you might see the video break up into squares. The captured
media is intact and complete, however.
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➤

Bug Number: UDEV00197055. When you capture media that includes invalid frames, you
might see an error message that the capture has been aborted and the invalid frames
discarded and it asks you if you want to keep the clip. This message is incorrect; the invalid
frames have not been discarded.
Workaround: Click No to discard the clip, and then recapture using new marks that
exclude the bad sections on the tape. Do not keep the clip.

➤

Bug Number: UDEV00204777. When you deselect Enable Confidence View in the Video
Display Settings dialog box and then open the Capture tool, the Client monitor does not
display passthrough.
Workaround: Do one of the following:
t

Select Enable Confidence View.

t

Click the Capture button in the Capture tool.

➤

Bug Number: . If you lose connection to your 1394 port or receive “OHCI Port Busy”
errors, check the FireWire cable length.

➤

Bug Number: . When you capture HDV, the system might not find the preroll point if the
Preroll setting is set to 3 or below. The default is set to 6. Do not set this option to 3 or below.

➤

Bug Number: UDEV00183907. (HDV) Passthrough does not work if Delay Audio is set to
7 frames or greater. (The Delay Audio option appears in the Capture tool.)
Workaround: Set Delay Audio to 6 or fewer.

➤

Bug Number: UDEV00181815. Drop frame/Non-drop frame mismatch errors occurred
often when capturing. A new Deck Preference setting has been added. Access the Deck
Preferences Settings dialog box. A new “When the deck contains no tape Log as” option
appears. Select the timecode format (Drop Frame or Non-drop Frame) for logging clips
when no tape is in the deck. When a tape is in the deck, the system automatically uses the
existing timecode format on the tape.

➤

Bug Number: . (HDV) When switching from one project format to another while connected
to an HDV device, you must turn the HDV device off and then turn it back on again.

➤

Bug Number: . (Windows) If after initially setting up a DV deck for the first time, or after a
system recovery you cannot see the deck, manually register the DV buffers file by doing the
following:
Workaround:
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Perform the following:

1. Go to Program Files\Common Files\Avid.
2. Right click Dvbuffers.ax.
3. Select Open.
4. Choose to select the program from a list and click OK.
5. Browse to windows/system32.
6. Select regsvr32.exe.

➤

Bug Number: UDEV00145432. The following error message appears if you attempt to
capture DV 25 from a DV 50 source or DV 50 from a DV 25 source: “Exception:
ADM_DIO_ERROR_OCCURRED, DIOerr:Expected DV50 NTSC but received
DV25NTSC.”

➤

Bug Number: UDEV00139553. When you batch capture long clips with a lot of metadata,
the following error appears and no media is captured: “Exception:
MXFDomain::SaveMetaDataToFile - Failed to save meta data to file.” This does not occur
when you batch capture OMF.

➤

Bug Number: . When you capture from a Panasonic AJ-SD93P or Panasonic AJ-SD93E,
note the following: the Panasonic default for DIF SPEED is set to S400. The Adrenaline and
Avid Mojo expect a DIF SPEED of S100. Capture fails, producing scrambled or blocky
images.
Workaround: From the Panasonic DVCPRO deck's menu, set the menu DIF SPEED to
S100.

➤

Bug Number: . When you capture DVCPRO HD from a Panasonic HD 1200A deck, keep
the menu DIF SPEED set to S400.

Compatibility
➤

Bug Number: UDevC00151255. If you are connected to the AJA Io Express and you are
performing a Capture on the fly and the Capture tool indicates that LTC is not advancing, go
to the Video Output settings and set the Sync Lock to Internal.

➤

Bug Number: UDevC00152345. Capturing video in SD progressive resolutions is not
currently supported if you are connected to the AJA Io Express.

➤

Bug Number: UDevC00152557. Playing 25i sequences that contain 1080p25 clips in 9
split Multicam mode is not currently supported if you are connected to the AJA Io Express
or Nitris DX.
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➤

Bug Number: . You might receive a “Host not responding” error if you are using NVIDIA
driver 259.77 configured for dual monitor setup and you apply a BCC 3D Objects filter.

➤

Bug Number: UDevC00151189. You might receive “DecompStream” errors when using
the mouse shuttle with XDCAM media.

➤

Bug Number: UDevC00144711. (Macintosh only) If you use a storage device formatted as
NTFS, you cannot perform any editing operation that requires the Avid editing application to
write information to the disk. The Macintosh operating system accesses information on
NTFS storage as read-only.

➤

Bug Number: . If you are running the editing application on a Windows 7 system and you
are connected to a DNA device, you might experience problems on power up, blue screens,
or capture problems. If you experience these issues, Avid recommends that you install the
hotfix described in the following Microsoft article:
http://support.microsoft.com/kb/2524249

➤

Bug Number: UDevC00148184. (Matrox MX02 Mini) In an HD project, you cannot play
back a multicamera sequence to the client monitor.

➤

Bug Number: . (Macintosh only) You cannot open the editing application help using
Google Chrome browser.
Workaround: Use Safari or Firefox as your web browser.

➤

Bug Number: UDevC00147535. (Macintosh only) Using Google Chrome browser to
create a Weblist preview for a Cut List in FilmScribe displays no content. Avid FilmScribe
does not support Google Chrome browser for Weblists at this time.
Workaround: Use Safari or Firefox as your web browser.

68

➤

Bug Number: UDevC00147229. (Macintosh) If Avid Log Exchange unexpectedly quits
attempting to convert a shot log to an ale file, try the following. Copy the shot log(s) into a
folder at the top level of the Mac boot drive and then try to convert the shot log(s) from this
new location.

➤

Earlier versions of the editing application refer to the audio drivers as Digidesign drivers.
The drivers are now referred to as Avid Audio drivers.

➤

Currently, Video Satellite is not supported with the Matrox MX02 Mini or the AJA Io
Express.
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➤

Bug Number: UDevC00136737. The Scrub and Pause field options in the Matrox MX02
Settings dialog have no effect on the final image.

➤

Bug Number: UDevC00129804. The list of available transcode resolutions in the Transfer
Settings list is not accurate. Some of the resolutions listed might be incompatible with the
current project’s media resolutions.

➤

Bug Number: UDevC00125617. Ancillary Data and Nitris DX: Due to software DNxHD
codec performance requirements, you must have a dual quad core system in order to capture
DNxHD 220 or 220x with ancillary data on the Nitris DX platform. If your system does not
meet the system requirements, the only way to capture DNxHD 220 or 220x is to make sure
that ancillary data is not enabled. (The HP z400 with hyperthreading supports capture of
DNxHD 220 or 22x with ancillary data.)
To switch the ancillary data feature on and off:

1. Select Tools > Console.
2. Type the following command: Embeddnxcc
OR
In the Media Creation Settings Capture tab, deselect Ancillary Data Enabled.

➤

Bug Number: UDevC00121033. Playing back EVS media on a Symphony Nitris (classic)
is not supported. Playback is supported for Symphony Nitris DX.

➤

Bug Number: UDevC00110632. (Windows) If you are running a Digidesign audio device,
such as the Mbox 2, with the editing application and that device appears to be inactive:
Perform the following:

1. Quit the editing application.
2. Run the Digidesign Audio Drivers Installer Program in the Avid Utilities folder.
3. Reboot the system.
4. If the audio device is still inactive, access C:\Program
Files\Digidesign\Drivers\DigiDriver.exe and select “Install.”
For Windows Vista 64, the location is C:\Program
Files(x86)\Digidesign\Drivers\DigiDriver.exe.

➤

Bug Number: UDevC00100881. You cannot connect to a Sony e-VTR device when using
e-VTR manager on a Microsoft Windows Vista32 or Windows Vista64 systems. The Sony
e-VTR logging application does not support Vista.
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➤

Bug Number: UDevC00112765. Currently, it might take longer to load a long-GOP 9-way
or Quad Split source view.

➤

Bug Number: UDevC00105849. If you open the AudioSuite tool when unlicensed plug-ins
are installed, the system will lock up.
Workaround: Either remove the demo or unlicensed plug-in from your system, or connect
the iLok dongle that has the valid license key to the system.
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➤

Bug Number: UDevC00104160, 00024645. If your original project was a 1080i50 or
1080p25 project, when you are working in a 25i PAL project, the bin headings for MPEG 30
and MPEG 50 might not be accurate.

➤

Bug Number: UdevC00102207. (Macintosh) If you find that your mapped F keys are not
working, go to System Preferences > Mouse and Keyboard > Keyboard tab and make sure
“Use F1-F12 keys to control software features” is checked.

➤

Bug Number: 99387. Currently, if you are exporting a QuickTime movie and select the
Custom option, you might receive an Access Violation and a Structured Exception loop
dialog. You must force quit the application or select Abort on the Structured Exception
dialog box. In QuickTime player, go to Edit > Preferences > QuickTime Preferences, then
select the Advanced tab and select “Safe mode (GDI only)” under video.

➤

Bug Number: UDevC00098170,UDevC00098065. If you are working on a
standard-definition (SD) project with an Avid Nitris DX or Avid Mojo DX attached to your
system, you cannot use the Best Performance mode for video playback. If you open an SD
project created on a system with an Avid Adrenaline attached and utilize Best Performance
mode, the Avid Nitris DX system promotes the video quality to Draft Quality. Either click
the Video Quality button and select Draft Quality or Full Quality, or change the project type
to the appropriate high-definition format.

➤

Bug Number: Udevc00101033. (Adrenaline, Windows Vista) If you are running your
editing application on the xw8400 or xw8600 computer you must have the HP 1394a
FireWire card (Avid PN 7030-20154-01; HP PN PA997A) or the Sonnet Technologies™
Allegro™ FW400 1394a FireWire card installed. You may experience “Huffman Decode”
errors during batch capture or capture on-the-fly if you run with an unapproved Firewire
card.

➤

Bug Number: UDevC00097564. Currently, if you are on a Windows Vista 64 editing
application and you try to open a bin that was created on a Windows XP editing application,
you might receive an “Unable to open file” message. The issue is that when you move a file
from the desktop to the project folder, it loses access rights. Access the file as an
administrator and add Authenticate Users with Full Control.
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➤

Bug Number: UDevC00093513. (Macintosh) The editing application might not launch if
your system volume name contains "/" . Make sure the computer volume name does not
include a “/”.

➤

Bug Number: . (Macintosh) When you are using the search feature in the Avid editing
application Help, a bug exists if Safari™ is your default browser. You might experience
issues when performing searches. You need to empty the Safari cache in between searches
(Select Safari > Empty Cache.) This search issue does not occur when you use Firefox™ as
your browser.

➤

Bug Number: UdevC00007737. If you are using an Mbox 2 and an HP8400 computer, you
should connect the Mbox 2 to a rear USB port. The USB ports on the front of the HP8400
can cause problems with the Digidesign Driver Installer. Once the installation is complete,
you can connect the Mbox 2 to the front or rear USB ports.

➤

Bug Number: UDevC00079523. If you are a non-administrator and you want to launch
AudioSuite Plug-Ins, make sure you have an administrator make you a member of the
AvidUsers group which is automatically created during installation.

➤

Bug Number: UDEV00141328. Sending to Digidesign® Pro Tools: When you export an
OMF 2.0 file that links to MXF media, you should first transcode the MXF Media to OMF
media. If you have a long sequence containing MXF media, you are not prompted prior to
the export process that the export will not be successful. To save time, transcode MXF media
to OMF media prior to exporting as OMF 2.0.

➤

Bug Number: UDevC00120475. Editing keyboard shortcuts such as Ctrl+X and Ctrl+C do
not work in MetaSync Manager. Use the menu commands.

Digital Cut
➤

Bug Number: UDevC00102676. When performing a digital cut, you will receive the
message “If you have a genlock signal connected to your BOB, please switch it to match the
output rate. Use an appropriate black burst sync source. Then wait for the REF light on the
BOB to turn green and press Continue.” If the light turns green, press Continue and the
digital cut will be performed. If not, make sure an appropriate sync source is connected and
wait for the REF light to turn green.

➤

Bug Number: UDevC00118267. A “Media Offline in Composition” error might occur
with a Digital Cut even when all media is online. Select Continue to perform the Digital Cut.

➤

Bug Number: UDEV01845957. When performing an HDV digital cut, the last few seconds
are not cut to tape.
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Workaround: Generate a clip of black and add it to the end of the sequence.

➤

Bug Number: UDEV00135921. When you perform a digital cut using the Pioneer®
PRV-LX1 DVD recorder, select Ignore Time in the Digital Cut Tool window.

➤

Bug Number: UDEV00136395. A video underrun might occur at the start of a digital cut if
the Digital Cut tool does not have focus when you click the Play Digital cut button. The
Digital Cut tool must be active before you click either the Start or Preview button. If an
underrun occurs at the very start of the digital cut, you should be able to perform the digital
cut without a problem.

➤

Bug Number: UDEV00139484. When you perform a digital cut to a Panasonic DVCPRO
HD deck using HD-SDI with 720p/59.94 material, several frames of black might be written
to tape before the start of the outputted sequence. This might result in the end of the
sequence being truncated on tape.
Workaround: Place several seconds of black or color bars at the end of a sequence.

➤

Bug Number: UDEV00138162. The Digital Cut tool does not allow certain durations of
black to be added to the tail of a sequence. Certain values (including 20 minutes, 30 minutes,
60 minutes, and so on) reset the clock to zero when applied. If the value you entered resets to
zero when applied, adjust the value upward or downward until a satisfactory length is
determined (at which point the clock does not reset itself and the desired duration is
correctly applied).

Dynamic Relink
➤

Bug Number: 103557. Any MPEG2 352_30I MXF media created with an x.8.1 or x.8.3
editing application will not relink in Exact match in versions x.8.4 of the editing applications
or the Media Composer 3.0 or Symphony 3.0 or NewsCutter 7.0 versions of the editing
application. The MPEG2 352_30I MXF media created with an x.8.1 or x.8.3 was
compressed at 15MB instead of 2MB and therefore will not relink in Exact match.
Workaround: Change the Dynamic Relink settings to use the “Most compressed” option
or change the “If no match is found” option to “Relink to Closest.”

➤

Bug Number: UDEV00225796. When working with HDV projects, HDV resolutions are
not available for Dynamic Relink.
Workaround: Choose “Use Closest Media” instead of “Relink to Offline” when in HDV
projects and “Specific Resolution” is selected as the Relink Method. If you do not choose
“Use Closest Media,” captured clips appear as offline when Dynamic Relink is enabled.
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➤

Bug Number: UDEV00221144. If you want to re-create title media at a target format other
than the working format, you must change the project format to that designated for the
target. Otherwise only the working format resolutions are available.

Effects
➤

Bug Number: UDevC00152563. When Offline Clip Color is enabled and the Timeline is
scaled in either direction, the video track might display odd track coloring and extraneous
effect icons for offline clips that have Timewarp effects. This is a redraw issue and does not
affect the contents.
Workaround: Disable Offline Clip Color.

➤

Bug Number: UDevC00145930. (Macintosh only) When you apply an effect that uses the
Intraframe drawing tools — for example, the Paint effect or the AniMatte effect — and then
click the Reshape button to change the shape you applied, you cannot access the Bèzier
curve handles by pressing Ctrl and clicking an edit point.

➤

Bug Number: UDevC00141398. If you have a created a sequence with the current editing
application containing AVX2 effects and you then open that sequence on an editing
application prior to Media Composer v5.0, NewsCutter v9.0 or Symphony v5.0, the effects
will not be recognized.
Workaround: Render the effects prior to opening the sequence in the earlier version
editing application.

➤

Bug Number: UDevC00133970. (Macintosh) (Boris Continuum Complete) When
switching from 8bit to 10bit display mode, you might see a shift in BLK levels.

➤

Bug Number: UDevC00136238. Boris Continuum Complete effects always stay at Safe
levels even if you had selected illegal levels.

➤

Bug Number: UDevC00134733. Rendering an effect in a software only configurations will
not preserve ancillary data.You must capture, edit and output the HD media with ancillary
data using Avid Nitris DX, Avid Mojo DX, Avid Adrenaline or Avid DNxchange
input/output hardware.

➤

Bug Number: UDevC00118276. You might experience dropped frames on the initial
playback of a sequence containing a Pan and Scan effect.
Workaround: Set the Image Interpolation option in the Render Settings to Standard
(Bilinear).
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➤

Bug Number: UDevC00112035. You might receive a bus error when exporting a sequence
in a 24p NTSC project that contains a scratch removal effect. Render the sequence first.

➤

Bug Number: UDevC00117131. Currently, you cannot preview Multi channel audio clips
with AudioSuite Dynamic 3 plug-in effects. The plug-ins work in the Timeline.

➤

Bug Number: UdevC00117990. If you try to conform an AFE created from the Avid Media
Composer or Avid Symphony editing application to Avid DS, the Color Correction
animation effects will not conform. The effects will be replaced with a wipe effect. You
should demote the color corrections. Right-click the sequence that contains the Color
Correction effects and select Demote Effects. This creates a a duplicate sequence that you
can open in Avid DS.

➤

Bug Number: UDevC00114633. When you apply a SubCap or TimeCode Burn-In effect to
a clip with the Effect Editor set to Thumbwheels, the first few characters in the text field are
cropped from view. They do appear properly on the image.

➤

Bug Number: UDevC00113832. Applying Boris Continuum Complete deinterlace above
other effects might corrupt the image.

➤

Bug Number: UDevC00115301. You might receive an “AudioSuite DAE” error when you
render a master clip with a ReelTape AudioSuite Plug-in. The error does not occur if you
render in the Timeline.

➤

Bug Number: UDevC00118588. The Tracking window becomes deselected after switching
from a nested effect to the top-most effect. You must close and then reopen the Tracking
window to make it available.

➤

Bug Number: UDevC00109451. When the Color Correction window is open, Loop Play
will include the sequence, not just the current clip, even if the Effect Editor is open.

➤

Bug Number: UDevC00120950. You might experience dropped frames when playing back
an HD sequence containing a Safe Color limiter effect with the “422 Safe” option selected.

➤

Bug Number: UDevC00113368. When working in 3D Advanced keyframes, occasionally,
keyframe points might not display in the path.
Workaround: Click the Enlarge or Reduce button located below the Effect Preview
Monitor.

➤
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Bug Number: UDevC00106944. In a 1080i59 project, effects that invert or resize the image
might appear field-reversed during play in an SD timeline.

Limitations and Known Issues

Workaround: Transcode the media to SD.

➤

Bug Number: UDevC00097157. A clip with an unrendered TimeWarp effect might not
import to Pro Tools. Render the effect before exporting.

➤

Bug Number: UDevC00090708. When you try to run AudioSuite you might receive the
following message, “Your computer is missing a Windows XP update required by ProTools.
Please install all available critical updates before installing Pro Tools.” If you do, you must
perform a Windows Update, Custom Install to ensure the correct .dll is installed.

➤

Bug Number: UDevC00003573. While in Effect mode, you might not be able to scrub
through blue dot effects and have the monitor update. Move the Effect Editor so that it
overlaps some part of the Composer monitor. The monitor should now update correctly
when you scrub through blue dot effects.

➤

Bug Number: UDEV00225614. Safe Color limits might be exceeded in SD downconverted
output from an HD project. In an HD project, if you use the Safe Color Limiter effect to
ensure safe colors in a sequence and then output that sequence using SD downconvert, some
transient pixel values might exceed your safe color ranges. This is a consequence of the
resizing process performed in the Avid Nitris or Adrenaline hardware during an SD
downconvert.
Workaround: Change the project type to an SD type before you output or render the
sequence.

➤

Bug Number: UDEV00219374. In 30i or 1080i60 projects, Timewarp effects that use the
Film With 2:3 Pulldown Input format might not render correctly. Some frames might remain
unrendered or it might not be possible to complete the render. This problem is known to
occur in the specific circumstances described below, but might also occur in other
circumstances.
Partial Render. The problem might occur if you perform a partial render of a Timewarp
effect using the Film With 2:3 Pulldown Input format, then render the remaining part of the
segment. Some frames might remain unrendered or the second part of the segment might not
render.
Division of rendered segment. The problem might occur if you render an entire Timewarp
effect using the Film With 2:3 Pulldown Input format, and then divide the segment (for
example, by performing an overwrite edit of new material into the middle of the segment).
Some frames in the second part of the divided segment might become unrendered.
Trimming head frame of rendered segment. The problem might occur if you render an entire
Timewarp effect using the Film With 2:3 Pulldown Input format, and then trim the head
frame of the segment. Some frames in the segment might become unrendered.
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➤

Bug Number: UDEV00207851, UDevC00141497. You might not be able to render a
FluidBlur, FluidColorMap, or FluidMorph effect in an HD project on a 32 bit OS system if
there is not enough memory available.
Workaround: Try one of the following:
t

In the Bins tab of the Project window, click the Clear button, and render the Fluid effect
(see “Managing Bins and Memory” in the Help).

t

Close all unused bins, relaunch, and render the Fluid effect.

t

In the Format tab of the Project window, switch the project format to an SD format,
render the Fluid effect, then switch back to HD.

➤

Bug Number: UDEV00221706. Very high speed Motion Effects with rates greater than
500% no longer play in real time; they now appear in the Timeline as a blue dot effect, and
must be rendered. Since any motion effect with a rate greater than 100% plays back
inefficiently, and the higher the rate the less efficiently it plays back, real time playback
efficiency will improve by rendering such motion effects.

➤

Bug Number: . (HDV) If a clip contains Timewarp effects, you should render the effects.

➤

Bug Number: . You might experience effects render issues with stacked effects.
Workaround: Render each individual track starting with the bottom track.

➤

Bug Number: . (Progressive projects only) If a clip contains any of the following effects,
you must render the effects before you apply Scratch Removal:
•

Timewarp effects

•

Any effect that has been promoted to the Advanced Keyframe model

➤

Bug Number: UDEV00134286. Removing or undoing some timewarp effects might cause
audio and video to lose sync.

➤

Bug Number: UDEV00161774. In the Transition Corner Display mode, two of the six
frames display incorrect frames during trim operations initiated from the Timeline.
Workaround: Trim using the Trim buttons.
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➤

Bug Number: UDEV00164929. (HD only) Any animated alpha matte over 35 seconds long
might fail.

➤

Bug Number: UDEV00163592. When an Avid effect is applied in an SD 24p progressive
project, it can create unwanted aliasing on the resulting clip.

Limitations and Known Issues

Effects (Pan & Zoom)
You might encounter the following limitations when you use the Pan & Zoom effect:

➤

Bug Number: UDevC00119611. If you run out of memory when using Pan & Zoom, resize
the images to a lower resolution using an application such as Adobe Photoshop software.

➤

Bug Number: UDevC00088408. (Macintosh) After the link to a Pan & Zoom effect is
broken and you want to reestablish it, the application doesn’t prompt you for the source
image name in the Open dialog box.
Workaround: Import still images into a bin and use them in the edit. With the imported
image in the Timeline, apply the Pan & Zoom effect and load the respective file from the
Open dialog box. This way you can use “Clip Text” and confirm that the correct images are
being loaded.

➤

Bug Number: UDevC00081281 . Pan & Zoom keyframe settings can revert to defaults if
you select all keyframes when you link to a new picture.

➤

Bug Number: UDevC00025291. When you zoom in with Hi Qual and Ultra Qual filtering,
you might experience a system error (Windows) or see green lines when you preview
(Macintosh).

➤

Bug Number: UDevC00090139. To improve memory issues, the options in the Pan &
Zoom Cache Fast menu are ignored and Video Resolution is used, although when you render
the effect, the highest-quality resolution is always used. After you partially render a Pan &
Zoom effect, however, you might see a slight pixel shift when you move between the
rendered and unrendered portions.

Export
➤

Bug Number: UDevC00158296, UDevC00147654, UDevC00129886. When exporting as a
QuickTime Movie, using the h.264 codec, the export might result in an “Exception: Movie
Export from procedures FAILED” error. Avid recommends you send the sequence or clip to
Sorenson Squeeze using a QuickTime Reference movie and then encoding to H.264 in
Squeeze.

➤

Bug Number: UDevC00141636. When you Export as AVI a sequence containing filler at
the end of the video track, you might receive an exception. Remove the filler at the end of
the sequence.
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➤

Bug Number: UDevC00142161. Performing an AVI Export using the Cinepak codec might
result in poor image quality. Using the Microsoft Video 1 codec does not result in poor
image quality.

➤

Bug Number: UDevC00142950 (Windows 7). An AAF export fails to create the file when
you export to an ISIS workspace.
Workaround: Save the file to a local drive first, then perform the export.

➤

Bug Number: UDevC00112498. QuickTime Movie export fails when using the Qualcomm
PureVoice audio compressor.

➤

Bug Number: UDevC00142475. If a sequence fails to import into EDL Manager from the
editing application using Get Sequence, use File > Open in EDL Manager instead to import
the sequence.

➤

Bug Number: UDevC00117134. (Mac Intel) You might have received “image buffer”
errors when exporting to DNxHD in Adobe After Effects® 7. This error does not occur with
After Effects CS3 or CS4.

➤

Bug Number: UDevC00090871. (Macintosh) When sending a QuickTime Reference to
Sorenson Squeeze, Auto Load and Reveal Files do not work. Squeeze will launch, but the
sequence does not load nor are the files revealed in the Finder window.
Workaround: Manually import the files into Sorensen Squeeze.

➤

Bug Number: UDevC00098849, 103011. (Macintosh) If you try to export to a read only
drive you may get an exception. Ensure you are exporting to a writable drive.

➤

Bug Number: UDevC00081152. An error might occur when you export to HDV when the
first frame of the sequence is a video mixdown clip.
Workaround: Place filler or a frame of non-video mixdown media at the head of the
sequence.

➤
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Bug Number: UDevC00049124. Currently, export settings allow a 720x486 size when you
export Avid DV, which creates a field alignment issue. Make sure that you set the export
settings correctly for 720 x 480 for DV exports. Currently, QuickTime must do a resize from
486 lines down to 480 and you receive an odd interpolation. (Even if you specify 720x486,
the QuickTime file displays 720x480.)

Limitations and Known Issues

➤

Bug Number: UdevC00054456. In NTSC, QuickTime Same as Source and QuickTime
Reference clips containing DV material can sometimes show visual distortions when burned
to DVD from Avid DVD. This is because the DV portions are resized from the DV raster
size 720x480 up to the standard NTSC raster size 720x486.
Workaround: When exporting the QuickTime Same as Source or Quicktime Reference
clips, choose “Use Avid DV.”

➤

Bug Number: UdevC00007778, UDevC00025957. (Macintosh) The editing application
might crash after exporting to an Avid Unity ISIS Read-only workspace. Make sure you
export to a Read/Write workspace. You can determine whether a workspace is Read/Write
through the Client Manager application. Navigate to the Workspaces tab in Client Manager.
The Read/Write workspaces are listed with an R/W under the name of the workspace.

➤

Bug Number: UDevC00078454, UDevC00081066. If you have a mixed-resolution DV 25
sequence and try to export it as QuickTime for DVD using the Apple DV Codec, the .mov
might contain artifacts.
Workaround: You must use the Avid DV Codec for this kind of sequence.

➤

Bug Number: UDEV00181835. When exporting to an HDV device, at least 4 to 5 seconds
of media might be missing from the beginning of the sequence.
Workaround: Add 10 seconds of color bar or black filler at the beginning and at the end of
the sequence.

➤

Bug Number: UDEV00140687. When you export a QuickTime Reference movie, do not
mix DV and non-DV media. If you mix DV and non-DV media, the resulting movie might
contain line shifts.

➤

Bug Number: UDEV00087119. When you export pan automation on an audio clip as AAF,
it does not translate in Pro Tools. Pro Tools does not accept varying value pan controls
during import.

➤

Bug Number: . In the Export Settings dialog box, the default size is not the image size of
the opened project.

➤

Bug Number: UDEV00086337. When you play an exported clip in the Windows Media
Player, the sequence stalls in the desktop monitor. The audio plays, the blue bar progresses
in the Timeline, and the video and audio output to the client monitor is OK. If the clip that is
loaded in Windows Media Player is removed, then the Play operation plays properly in both
the desktop and client monitors.
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➤

Bug Number: UDEV00138232. Exporting Locators exports only a .txt file with frame
count information, not timecode or Feet and Frames. Import also supports only frame count.

➤

Bug Number: . (Encoding to Windows Media) A “Not enough memory is available to
complete this operation or WM_BeginWriting_FAILED” error results from the application
running out of available memory (RAM) while you perform the encode. Encoding to a
Windows Media Video codec requires a lot of memory. The amount of memory required is
directly related to the number of audio and video profile streams, width, height, bit rate,
number of passes, VBR/CBR, and quality of the encoded video, as well as the resolution of
the source media. If you encode HD media, you might need to reduce the bit rate, turn on
2-pass encoding, turn on VBR, lower the quality, or reduce the frame dimension.

➤

Bug Number: . A “WM_FindInputFormat_FAILED” error might appear if the Windows
Media exporter cannot find a suitable input format for a video or audio stream contained in
the current Windows Media Export setting's stream profile. For example, using non-standard
frame dimensions might result in this error. See the Microsoft Windows Media Web site for
more detail.

ICS (International Character Support)
➤

Bug Number: UDevC00149067. (FilmScribe) Japanese characters used for clip names,
custom column headings, and other textual information do not display correctly in Avid
FilmScribe.

➤

Bug Number: UDevC00145173. If you use Japanese characters to create a tape name in the
Capture tool that exceeds the maximum of 32 characters, the tape name appears with
nonstandard characters, such as question marks (????).
Workaround: Create a new tape name with fewer than 32-characters.

➤

➤
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Bug Number: UDevC00146771, UDevC00148416, UDevC00148417. Using Marquee
with title media that contain Japanese characters in the name of the saved titles can cause
errors.
•

When you create a title in Marquee using non-English characters, you cannot export the
title media as AAF and then import it to a bin in a different project.

•

You cannot create a title in the Title tool with Japanese characters in the name and then
promote it to Marquee.

•

You cannot edit a title in the Timeline with Marquee if the title media is named with
Japanese characters.

Bug Number: UDevC00146773. You cannot open Marquee if your user name includes
Japanese characters.

Limitations and Known Issues

Workaround: Change your user profile name to use non-Japanese characters and then open
Marquee.

➤

Bug Number: UDevC00148278. If you use an input method for a non-English locale to
name clips or sequences with integers, and then sift the column on a system with an English
locale setting, the sift operation does not order the bin items correctly.

➤

Bug Number: UDevC00147746. If you type a tape name with Japanese characters and that
exceeds the maximum length of 31 characters in the Source Tape Display field in the
Capture tool, the Avid editing application does not truncate the tape name but instead
displays the tape name with incorrect characters.
Workaround: Rename the tape using no more than 31 characters.

➤

Bug Number: UDevC00147539. (Macintosh only) You cannot use Japanese characters for
the output directory location in the File Name Control area of the Render Options dialog box
in Marquee.

➤

Bug Number: UDevC00143963. (Macintosh only) When you create titles with Marquee,
you cannot use the keyboard to type Unicode characters directly into Marquee.
Workaround: You can copy and paste Unicode characters from a text editor into Marquee.

➤

Bug Number: UDevC00143455. When you create an export template, you cannot paste
Unicode characters into the Save As dialog box if you copied them from a file name.
However, you can paste Unicode characters copied from a text file.

➤

Bug Number: UDevC00142431. If you use a text editor such as Notepad to paste Unicode
text into the Comments field for a clip in Script view, the Unicode characters might not
display correctly.

➤

Bug Number: UDevC00145069. (Macintosh only) If you use the Kotoeri input source to
type Hiragana, Katakana, or other Japanese characters in a clip name text box or in the Title
tool on a system with an English operation system set to a Japanese locale, the Japanese
characters do not appear in the application text box.
Workaround: As you type, the operating system opens a text box at the bottom of the
monitor that contains the characters you type until you press Enter twice. When you press
Enter the first time, focus returns to the application text box for the text you want to change.
When you press Enter the second time, the text with Japanese characters appears correctly.

n

Some keyboard shortcuts that do no use a modifier key — for example, pressing the “I” key
to set an In point — might also open the operating system text box.
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If the operating system text box at the bottom of the monitor does not open, in the Project
window select a bin to rename it. As you start typing, the operating system text box opens.
You press Escape to cancel the bin name change once the text box opens.

➤

Bug Number: UDevC00051974. If you capture a clip from a workspace with a French
name through CaptureManager™, in the Avid editing application the bin heading Drive
might be empty where it should list the French name of the workspace.

➤

Bug Number: UDevC00051060,UDevC00088815. If you change the font or font size of
your input, and see characters rotated 90 degrees, make sure you select the correct font. Do
not use any font that begins with the “@” symbol.

➤

Bug Number: UDevC00052541. Do not create a project using the Euro currency character
(ALT 0128). The project fails to be created and a “Can't Open Project” error message is
displayed.

➤

Bug Number: UDevC00022395, 22346. Certain Asian characters might not appear in the
correct order in some text boxes in your Avid editing application.

Import
➤

Bug Number: UDevC00049653. Occasionally, if you cancel an import of a clip, you might
receive a “DISK_SHARING_VIOLATION” error.

➤

Sample rate conversion is not performed on import of AVCHD files. AVCHD files will be
imported at their native sample rate, regardless of the “convert sample rate” setting.

➤

Bug Number: UDEV00086727. When you import an uncompressed QuickTime file, a
PICT image, or a TIFF image, the first 4 or 5 vertical columns of pixels might truncate when
you display the file in the Source, Record, or client monitors.

➤

Bug Number: UDEV00141372. When you batch import a sequence with a graphic
animation that was created in a 30i project and then modified in a 720p project, it might not
import.
Workaround: Import the graphic and manually edit it back into your sequence.

Installation
➤
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Bug Number: UDevC00102551. (Macintosh) When launching the editing application, and
the Audio is initializing, “CoreMIDIServer.framwork” might bounce in the dock. It may
remain in the dock until you quit the editing application.

Limitations and Known Issues

Workaround: Delete DigiDioMidDriver.plugin from the Library/Audio/Drivers folder.

➤

Bug Number: UDevC00150879. To launch the editing application as an administrator
right-click the product.exe and select Run as administrator. The executable is located (by
default) in C:\Program Files\Avid\Avid Product Name. Run as administrator is not available
by right-clicking in the Avid editing application Shortcut icon.

➤

Bug Number: UdevC00106344. After installing the editing application on the Windows
Vista OS, when you choose to reboot the system, the shutdown cycle is longer than usual.

➤

Bug Number: UDevC00103563. On Windows platforms, occasionally the PACE installers
do not properly update the iLok drivers. PACE iLok drivers are used to copy-protect
Digidesign plug-ins. If this happens, the AudioSuite functionality in Media Composer will
be disabled. To correct the situation the user should uninstall all instances of Interlok Drivers
from the Windows Add Remove Control Panel and re-install the Digidesign Drivers from
the CD or from Avid > Utilities.

➤

Bug Number: UDevC00103474. (Windows Vista) When the editing application is launched
and a firmware update is required, you might be prompted to relaunch using “Run As
Administrator”. To run as administrator, right-click the product.exe and select Run as
administrator. The executable is located (by default) in C:\Program Files\Avid\Avid Product
Name. Run as administrator is not available by right-clicking in the Avid editing application
Shortcut icon.

Interplay Workgroup
➤

Bug Number: UDevC00141396. It might appear as though the Restrictions menu is
missing from the Tools menu in the editing application. The option does not appear until you
perform an Update from Interplay on a sequence or clip that contains a restriction.

➤

Bug Number: UDevC00140928. Your Avid editing application might hang if you open a
window in another application (for example, an Interplay component such as Interplay
Access, or a web browser) while you are playing an in-progress (Frame Chase) clip. If this
happens and the following error appears, you must relaunch your Avid editing application:
AMEResourceManager::ReconfigVideoHoldFrame()
Error [-16777183] unable to:
SetVideoHoldFrame.

If other errors appear, you might be able to dismiss the message box and continue working.
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➤

Bug Number: UDevC00131432. If you double-click a Mixed Frame Rate sequence in
Interplay to load it in the monitor, you might receive the following message. “Use
modify/set format feature to convert this sequence.” You should check out the sequence into
a bin first in order to use the modify/set feature.

➤

Bug Number: UDevC00105773. When you create a video or audio mixdown and add a
locator, you might receive an “Exception: CM_NO_TC” error when you try and check the
clip in to Avid Interplay. If you add the locator in Assist, then go back to the editing
application and perform an Update from Interplay on the clip, the clip will check in
successfully.

➤

Bug Number: UDevC00105408. (Windows Vista) If you have a P2 drive mounted and you
try to open the Interplay Service Configuration tool, you might receive an Exception error.
Clicking through the error message might allow you to open the tool. If you unmount the P2
drive, the tool will open.

➤

Bug Number: . When checking out a complex or long sequence from an Avid Interplay
environment the following message might appear: “A request for data from the asset
manager is taking a long time to complete. Would you like to continue waiting for the
operation to complete or would you like to cancel?” If you choose to wait the sequence may
load or you may get this message multiple times until the check out actually occurs.

➤

Bug Number: UDevC00091228. Selecting Check In All Open Bins from the Fast menu
(hamburger menu) in the bin might not check in the open bins.
Workaround: To check in all open bins, select Check In All Open Bins from the File
menu.

➤

Bug Number: UDevC00090338. After you perform a search for media in the Interplay
Window, you cannot refresh the search results displayed in the Research panel by pressing
F5. If you want to refresh the results, repeat the search.

➤

Bug Number: UDEVC00052480. Batch Import of files containing Alpha. This problem
occurs if you want to batch import files in SD and HD formats and then use Dynamic Relink
to switch between the different formats. The problem occurs with QuickTime movies,
graphics, and sequences that contain alpha. You can batch import the files and relink to the
different formats, but if you exit and then restart the Avid editing application you can no
longer relink to the HD format. The system displays an “Exception: NO Compressed Data
Format found” error message.
Workaround: You cannot use Dynamic Relink with HD and SD clips that contain alpha.
Import the HD files with alpha as individual clips. When you want to switch to HD format,
edit the HD versions into your sequence.
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Limitations and Known Issues

➤

Bug Number: UDEV00227044. If you import a graphic from your local drive into a project
in an Avid editing application, change the original name of the clip to a name of your choice,
and check that clip into a folder in the Interplay Window, the new name does not appear in
the Interplay Window even when you refresh the window. You see only the original name.

➤

Bug Number: UDEV00217606. In the Avid editing application, the Record Track monitor
buttons might be deselected if the following happens:

1. On system1, create a sequence and check it into a folder in the Interplay Window.
2. On system2, check out the sequence and load it into the Timeline.
3. On system1, edit the sequence and check it into the Interplay folder again.
4. On system2, refresh the Interplay window then check out the same sequence again.
Workaround: Select the Record Track buttons again.

➤

Bug Number: UDEV00299154. In an Avid editing application, if you have a sequence that
you have not checked into the Interplay Window and you try to use the Transfer > Send to
Workgroup command, you might experience an error.
Workaround: Check the sequence into the Interplay Window before you attempt to
transfer it.

➤

Bug Number: UdevC0055755. When working with MultiRez, high-quality audio cannot be
distinguished from up-sampled proxy audio created with previous versions of the editor. For
instance, an 8 kHz proxy audio up-sampled to 48 kHz on import in Interplay version 1.0 is
considered as good as a real 48 kHz high quality audio. In that case, if MultiRez is set to use
48 kHz audio, it picks up the most recent of the two files.

Force Disconnect Client Mode in an Interplay Environment
Your system administrator might need to temporarily remove your editing system from
access to the network. This might occur if new software needs to be installed or if
components need to be updated, for example. To force a disconnect, your administrator runs
a script that forces disconnection from the network without physically removing your
system. Your administrator can also reconnect your system at the appropriate time using
another script.
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It is possible to import from shared drives and export to them in Forced Disconnected Client
mode. Avid recommends, however, that you do not import from or export to shared drives
when your administrator has force-disconnected your editing system. Avid does not support
any workflow that includes importing from or exporting to shared drives when the system is
in Forced Disconnected Client mode.
In general, if you are in Forced Disconnected Client mode and if you import or export using
shared drives, after the import or export those drives might appear to be available for other
purposes such as importing, capturing, playing, or deleting media, but they are not available.
Similarly, options for shared storage might appear to be available in various settings dialog
boxes and shared drives and media might appear in various menus, tools, and applications;
Avid does not support use of these settings, drives, or media.
To remove the shared drives from your drive lists, disconnect your network cables as
described in “Voluntarily Disconnecting from the Interplay Environment” in the Help, or
exit your editing application and restart it.
The following limitations describe specific instances of drives and options appearing in
Forced Disconnected Client mode:
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➤

Bug Number: UDevC00083319. In the Select Project dialog box, shared workspaces and
projects are available and should not be.

➤

Bug Number: UDevC00083320,UDevC00083772. Shared drives and media are available
in the Media tool and in the MetaSync™ application and should not be.

➤

Bug Number: UDevC00083321. In the Interplay Server Settings dialog box, you can
change the Interplay server name and you should not be able to.

➤

Bug Number: UDevC00083371. In the Capture tool, you can select the Interplay Folders
option as your capture destination and you should not be able to.

➤

Bug Number: UDevC00083374. In the MXF Media Files tab of the Capture Settings dialog
box, you can select the “During capture, clip is updated in Interplay” option and you should
not be able to.

➤

Bug Number: UDevC00083477. In the Temporary File Directory option of the General
Settings dialog box, you can type the name and location of a shared drive and you should not
be able to.

➤

Bug Number: UDevC00083409. Shared drives and media are visible in the Hardware tool
and should not be.

Limitations and Known Issues

➤

Bug Number: UDevC00083740. Shared drives are visible in the Import dialog box and
should not be.

➤

Bug Number: UDevC00083826. Options in the Media Services Settings dialog box are
available and should not be.

➤

Bug Number: UDevC00083496. Options in the Transfer Settings dialog box are available
and should not be.

➤

Bug Number: UDevC00084455, 84773. Selecting LANshare, PortServer settings, or
ProEncode™ appears to be available but should not be. Do not select these options.

➤

Bug Number: UDevC00084446. Dynamic Relink can be enabled but that should not have
been allowed. Do not enable it.

➤

Bug Number: UDevC00084600, 84844. With several of the options in the File menu, you
are allowed to select a shared workspace as a destination but you should not be able to. Do
not select a shared workspace in this context.

➤

Bug Number: UDevC00084610. If you select Automatic Login at Project Selection in the
Interplay User Settings dialog box, enter Disconnected Client mode, exit the mode and the
editing application, reconnect, and then restart the editing application, you need to log into
Interplay again and you shouldn’t have to.

➤

Bug Number: UDevC00088542. In Forced Disconnect mode, if you make a change to your
User settings, the change might appear for all other users, as well.

JVC
➤

Bug Number: UDevC00142188. Using the JVC BR-HD50 deck is not currently supported
when working on a Windows 7 system.

➤

Bug Number: UDevC00106545. JVC recommends using the BR-HD50 deck to capture
and batch-capture HDV media recorded with JVC cameras.

➤

Bug Number: 106030. The JVC GY-HD250U camera might drift out of sync while
shooting in 720p/59.94. To avoid this issue, turn on the camera in 720p 23.976 and then
switch the format to 720p 59.94 causing a soft reboot.

➤

Bug Number: UdevC00106401. Currently, captured or imported M2T files might contain
1/2 frame offset. This occurs in 720p 29 and 720p 25 projects.
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Locators
➤

Bug Number: UDevC00080303. If you add a locator to a shotlist, and then open the
sequence in an editing application, the locator appears, but if you perform a match frame on
the locator, it might not appear in the master clip.
Workaround: In the editing application, check the master clip in question out of Interplay
and then update the bin or the clip. The locator appears.

➤

Bug Number: UDevC00079172. (Macintosh) When you export locators from the Locator
tool, the file might not be saved with the correct .txt extension and you might not be able to
import it.
Workaround: In the Choose Location for Exported Locators dialog box, add the file name
extension .txt to the end of the file name before you click Save, or add the extension to the
saved file before you import it.

Mixed Frame Rate and Field Motion Types
➤

Bug Number: UDevC00139723. If you perform a transcode across frame rates, the final
frame might appear as an offline slide.

➤

Bug Number: UDevC00126375. If you are sending a mixed resolution sequence to
playback, make sure “Same as Source” is unchecked in the Media Creation Settings Render
dialog box. The render format must match the primary playback format.

➤

Bug Number: UDevC00129278. When you bring a mixed frame rate sequence into Pro
Tools, make sure the “Ignore rendered audio effects” option in Pro Tools is disabled. If the
option is selected, the audio for any mixed frame rate clips will be missing from the
Timeline.

➤

Bug Number: UDevC00129238. Some motion effects on Long GOP media might display
as non-realtime effects where in the past they displayed as real-time. This might occur under
the following conditions.
•
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The video track of the underlying clip is a spanned clip. For example, a spanned clip is
one where the master clip originated from an XDCAM EX device, or a master clip that
has been modified by dynamic relink after an operation such as partial restore. You can
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usually tell if a master clip is spanned by loading the master clip into the Source
monitor, switching the Timeline to display the contents in the Source monitor and look
for edits in the video track.
•

The portion of the master clip being used by the motion effect crosses a span boundary.

This change also affects the motion adapters used when mixing frame rates and field motion
types. If you have a spanned Long GOP master clip and you load it into the Source monitor
of a project with a different edit rate, the video will not play in real-time in the Source
monitor. If you edit a portion of the clip into a sequence, the resulting clip in the Timeline
might play in real-time if the IN and OUT points do not cross a span boundary; otherwise it
will remain non-realtime and you must render it to play it in real-time.

➤

Bug Number: UDevC00129602. Clips with mixed frame rates and field motion types are
treated as Optical effects in FilmScribe. In order to generate a valid FilmScribe list, you
must enable Optical in FilmScribe. Otherwise, the clips containing mixed frame rates and
field motion types will reference an Optical list that does not exist.

➤

Bug Number: UDevC00122550. You cannot apply a Timewarp effect on top of a Motion
Adapter effect. If you attempt to do so, an “Effect does not apply” message appears.
However, you can promote a Motion Adapter effect to a Timewarp for full access to all
Timewarp effect parameters. For more information, see “Viewing and Adjusting Motion
Adapter Parameters” in the Help.

Panasonic
➤

Bug Number: UDevC00101216. Reveal File does not function on master clips linked from
P2 cards or virtual volumes.

➤

Bug Number: UDevC00098594, UDevC00097992. Panasonic P2 writeback is not
supported on the Macintosh platform.

➤

Bug Number: . Export to P2 limitations:
•

Use Marks and Use Enabled tracks are ignored on export.

•

All Audio must be PCM 16b/48K.

•

All audio tracks will be exported, although P2 devices either support 2 or 4 audio tracks.
Therefore sequences should be built for delivery to the specified P2 playback device.
Sequences with 6 audio tracks will have 6 audio tracks and the P2 device will only
playback the first 2 or 4 tracks.
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➤

Bug Number: . Importing P2 limitations (Macintosh):
•

Importing P2 Clips in a bin is only supported with one P2 Card mounted. With two or
more P2 cards mounted, use the Media Tool, select the P2 Drives, click All Projects and
click OK. All Master Clips from the P2 cards will appear in the Media Tool. Drag them
to a bin.

•

When importing from the Panasonic P2 Store device, Media Tool must be used as well
on Macintosh.

➤

Bug Number: . SD/HD Mixed sequences are not supported.

➤

Bug Number: . 1:1 MXF media cannot be exported in both SD and HD projects. Transcode
1:1 MXF before exporting.

➤

Bug Number: . (Macintosh) Hotswapping P2 cards with the editor launched is currently not
supported.

➤

Bug Number: UDevC0056503. When you view a P2 clip that spans across multiple P2
cards in the timeline, you might be surprised as to what you see and don't see due to the
history of mounting P2 cards on your current system and the P2 cards that are currently
mounted. Be aware that even though media is offline, or you are not able to view the P2
media in the Timeline, the media is not lost. The media appears when the card containing it
is mounted.

➤

Bug Number: 00080719. If you have P2 clips on a P2 card and you display the clips in the
Media tool, you might be able to delete the audio and video .mxf files from the Media tool.

➤

Bug Number: UdevC00058135. If you remove a card from a slot in the P2 reader and do
not put another card in the reader, you must delete the P2 folder before inserting that same
card in another slot.

➤

Bug Number: UdevC00058133. A DVD drive cannot be a media drive. If a CONTENTS
folder is located on the root level of the DVD, you might see a “No clips were found”
message when performing an Import P2 Clips to Bin.
Workaround: Create a folder that contains the CONTENTS folder on the DVD. This
instructs the editor to mount a virtual drive.

➤
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Bug Number: UDevC00051731. When the P2 CONTENTS folder is located at the root
level on a drive where the Avid editing application looks for media files, you might
encounter errors when importing P2 clips. For example, if you are working on a laptop, the
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Avid editing application and local storage folders are on the same drive and are usually
located at the root level. If you create virtual P2 volumes on the Desktop, you might
encounter a “No clips were found” message when trying to import the P2 clips and media.
Workaround: If you locate the virtual P2 volume in a different location such as a subfolder
on the Desktop, you should be able use virtual P2 volumes.

➤

Bug Number: . If you experience unusually long scan times, check to make sure both the
local time and Greenwich Mean Time (GMT) are set correctly on your camera. If the GMT
is not set correctly, you may need updated firmware for your camera.

➤

Bug Number: . Play performance for a multi-stream sequence suffers when you directly
access media from the P2 media cards in the AJ-SPX800P camera.

➤

Bug Number: UDEV00163029. If you turn off the P2 card reader while a bin accessing P2
media is open, attempting to load any P2 clip results in a DISK_FILE_NOT_FOUND
message in the Source monitor window. The message should read Media Offline.

➤

Bug Number: . The following limitations currently apply when working with AVC-Intra
resolutions:
•

Playback of AVC-Intra is not supported with xw8400 or xw4600. Newer hardware does
support playback.

•

Real-time playback support on Avid Symphony Nitris is not guaranteed.

•

Performance is limited when you transcode or mix down a sequence to an AVC-Intra
resolution. These operations can take up to four times real time to complete (up to four
minutes for a one-minute sequence).

➤

Bug Number: UDevC00139239. Performance is limited when you transcode or mix down
a sequence to an AVC-Intra resolution. These operations can take up to four times real time
to complete (up to four minutes for a one-minute sequence).

➤

Bug Number: UDevC00128615. When using AVCIntra media, be aware that this resolution
uses more memory than other formats.

➤

Bug Number: UDevC00116685. You cannot export a QuickTime movie using the Same as
Source option with AVC-Intra material. ProEncode does not work with AVC-Intra material.
This is related to the QuickTime problem because ProEncode creates a QuickTime
Reference movie as part of its process.

➤

Bug Number: . If you encounter unusually long consolidation times when working with the
P2 device, make sure you are using the USB cable supplied by the P2 manufacturer.
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PhraseFind
➤

Bug Number: UDevC00148550. (Windows only) During the start up of Avid's PhraseFind
feature, the system indexes your media files. If your Windows Firewall is turned on, you
might receive a Windows Firewall message informing you that the Indexer is blocked.
Dismiss this message by selecting Yes to allow the indexing process to continue.

➤

Using PhraseFind or finding text in an Avid Interplay environment: When you perform an
Edit While Capture in an Interplay environment, you need to update the bin so that the
system indexes your new media.After you capture, right-click the clip in the bin and select
Update from Interplay. Then save the bin. When you perform a PhraseFind or search for
text, the system should find the new captured clips.

➤

Bug Number: UDevC00151192. Entering numbers during a phonetic search (PhraseFind)
results in an error message.
Workaround: Spell out the number (for example: one, two, thirty three) you are searching
for.

Play
➤

Bug Number: UDevC00145107. (Macintosh only) The keyboard shortcut to loop Play In to
Out (Ctrl + Play In to Out button) no longer starts a playback loop.

➤

Bug Number: UDevC00145469. (Windows only) The mouse pointer does not change to a
lasso when you press Alt with the mouse pointer to lasso segments in the Timeline.

➤

Bug Number: UDevC00145110. Pressing Ctrl + Play to Out button no longer starts a
playback loop. This occurs if you use the Play to Out button in the Command palette or if
you map the button to the Tool palette or to a toolbar.
Workaround: You can start a playback loop if you first map the Play to Out button to the
keyboard, and then press Ctrl + [keyboard button]. For more information, see “Mapping
User-Selectable Buttons” in the Help.
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➤

Bug Number: UDevC00147665. Currently, Multicam and dual rolling trim for 720p25,
720p23.976 and 720p29.97 will play to the desktop but will not update the client monitor as
in software mode.

➤

Bug Number: UDevC00148038. You will receive a Timeout error when scrubbing a
VC1-APL3 clip.
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➤

Bug Number: UDevC00148248. sequences with multiple streams might drop frames at cut
points on start of playback. This might be caused by the Nvidia display power save option.
You could experience this with 3800 and 4800 graphics cards. To workaround this, set the
Nvidia power management option to Prefer maximum performance mode:
To set the Prefer Maximum Performance mode:

1. Right-click the Desktop, and select Nvidia Control Panel.
2. Click Manage 3D Settings.
3. Set Global presets to Base profile.
4. In the Global Settings tab, change Power Management mode to Prefer Maximum
Performance.
5. Click Apply.
6. Set the Global preset to 3D App-Video Editing.
7. Click Apply.

➤

Bug Number: UDevC00137818. AVC-Intra media will not play or will stutter when
playing on systems less capable than an HP xw8600.

➤

Bug Number: UDevC00109242. (MacBook Pro) After an initial launch of the editing
application when attached to a Mojo, you might receive an “Assertion failed” error when
playing back an HD sequence.
Workaround: Switch the project to NTSC or PAL.

➤

Bug Number: UDevC00101060. You might experience a slight delay at the start of play
when Output to DV Device is enabled with progressive projects.

➤

Bug Number: UDevC00117987. On certain slower machines, when playing in
MultiCamera mode, you might notice one or more cameras or the line-cut stutter a few
seconds into the sequence. This happens most often when displaying the MultiCamera
composite or line-cut to the client monitor on these older, slower systems. To help improve
performance, Avid has provided a console command which allows you to pre-render more
frames. This will slow down the start of play, but improve the overall playback
performance.To increase the number of pre-render frames:
Perform the following:

1. Open the Console window by selecting Tools > Console.
2. In the Console command line, type the following command followed by the number of
frames you want to pre-render:
multicampreload 20
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3. Press Enter (Windows) or Return (Macintosh). The value is saved. You do not need to
reenter the command when you relaunch the editing application. To restore the default
value, enter the command with no value.
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➤

Bug Number: UDevC0088738. When you scrub a clip with “Fast Scrub” on, you might
notice that when you stop scrubbing, the video continues to play in the record monitor. This
might be more noticeable in HD projects or when you are working on shared storage. Fast
scrub actually has a number of frames in flight while you drag the blue bar. The in process
frames continue to play once you stop scrubbing.

➤

Bug Number: UDevC00026088. When you play media and then you press stop, the Source
monitor stops, but the external client monitor steps back approximately 2 frames.

➤

Bug Number: . (Macintosh) QuickTime reference movies are useful as long as you are
working with Avid media files available on your local system or in an Avid Unity
environment. However, if you expect to move the exported QuickTime file to a system that
doesn't have access to the media, then you should use the standard QuickTime export so the
media files and QuickTime wrapper can be moved as one file.

➤

Bug Number: Udev00209633. With Full Screen Playback enabled on a single monitor, the
video might stutter and you might notice tearing toward the top of the image during
playback. Tearing might also appear if you use variable-speed play.

➤

Bug Number: . When the Avid editing application stops streaming play, a number of
additional frames are sent to the DNA device in order to keep the client monitor synchronous
with the desktop display. The DNA device must play out that number of frames after the
desktop has stopped playing. To make sure you view the actual last frame, the application
then snaps the client monitor back to the frame on the desktop. This might be more apparent
when playing HD media.

➤

Bug Number: . If you do not see video output to your device, make sure that the appropriate
device is selected in the Special > Device menu. If FireWire is selected in the Device menu,
make sure Output to Device is selected in the Video Display Settings.

➤

Bug Number: Udev00141002. If you experience a flashing monitor when attempting to
play using the Japanese version of Windows XP, and your monitor does not appear to be
covered by anything, adjust the state of your Language bar by maximizing and minimizing
it. This restores the ability to play.

➤

Bug Number: . (Adrenaline) LTC output is now off by default. To turn it on, open General
Settings and enable “Generate LTC On Playback.”
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Projects
➤

Bug Number: UDevC00137703. If you create a project at the top level of a workspace, you
might receive a Disk_IO_Timeout error.
Workaround: Selecting a folder on the workspace does not result in an error.

➤

Bug Number: UDevC00100476. The following project types do not support XDCAM or
HDV raster types:
•

1080p 23.976

•

1080p 25

The only raster type available for these formats is Standard.

➤

Bug Number: UdevC00025426. (Windows Only) Avid Attic folders can only be created by
Administrators. An Administrator has to first launch the application, open a project, close
the project and quit the application. Then when a non-Administrator user uses the
application, their work is saved to the Avid Attic.

➤

Bug Number: UDevC00099790. You should note the following when transcoding media. If
you have a project in one format, such as 1080i 50 and you add a supported progressive
format to the clip such as 1080p 25, once you transcode the media, if you try to delete the
clip, the clip contains both progressive and interlaced media. The delete dialog does not
indicate that the clip you are trying to delete contains both progressive and interlaced media.

➤

Bug Number: UDevC00025979. For NewsCutter projects, you can only select base
timecode (TC1) display formats in the Tracking Information menu. You can view other
timecode formats in the Timeline window, but tracking information does not display above
the Source/Record monitor except for the base timecode.

Settings
➤

Bug Number: UDevC00100486. Currently, when saving toolsets, the bin position is not
saved.

➤

Bug Number: . Do not carry User Profiles from a previous version to this version. Create
new user settings. If you do use previous settings, the size of tools and windows might not be
as expected, especially tools and windows that have been updated for this version.
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Titles
➤

Bug Number: UDevC00133927. You cannot save a Marquee Title if you are a Standard
User. To workaround this issue:
Perform the following:

1. Log on as Administrator.
2. Navigate to Macintosh HD/Users/Shared/Avid Media Composer/
3. Select MarqueeTitles and select File > Get Info.
4. Select Sharing & Permissions.
5. Click the Padlock icon and enter an administrator password.
6. Click the button with the Gear icon at the bottom of the pane.
7. Choose Apply to enclosed items.
8. Select OK to apply the selected owner, group and permissions to the enclosed items
dialog.
A standard user should now be able to write to the Marquee Titles directory.

➤

Bug Number: UDevC00107356. (Macintosh) You might see vertical gray lines when you
horizontally scroll the pages of a crawling title in Title Tool.

➤

Bug Number: UDevC00054752. If you re-create a rolling or crawling title in your
sequence, the Scroll Position parameter values for the first and last keyframes are not
preserved. They are set to the default values (start and end).
Workaround: Promote the title to advanced keyframe model before you re-create.

➤

Bug Number: UDevC00047857. (Macintosh only) If you select the classic Title tool
eyedropper and then quit the Avid application, the application hangs.
Workaround: Deselect the Title tool eyedropper before you exit the Avid application.
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➤

Bug Number: UDevC00080610. Avid suggests that you do not attempt to edit the nested
tracks of a re-created rolling or crawling title. If you attempt to select or edit one of these
types of nested tracks, an error occurs. This is also the case with a re-created static title on its
alpha channel subtrack.

➤

Bug Number: UDevC00080134. A sys_error occurs when you modify a title to an available
drive with Render settings that are set to an unavailable drive (a drive that you do not have
write access to). A .bak file of the title also appears in the bin.
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Workaround: Close the Title tool and change the Render settings to a drive that you do
have write access to.

➤

Bug Number: UDevC00024196. Character spacing might be inaccurate in Title Tool titles
using large font sizes. Some character pairs might appear too close together, or overlapping.
In HD projects, the problem is only visible in the rendered title clip in the bin. In SD
projects, the problem is visible immediately in the Title Tool. Also, once the problem has
occurred in text using a large font size, it might persist when you create other text objects in
the title at any font size.
Workaround: The best general workaround is to promote the title to Marquee®. Text in
Marquee titles does not have the same problem at large font sizes. Also, if you do not need
your final text to use a large font size, avoid converting it to a large font size at any point in
your workflow, or retype it as a new text object at a smaller size if increasing the font size
causes the problem.

➤

Bug Number: UDevC00024064. Marquee title format does not need to change in normal
workflows. In most normal workflows, the title format in Marquee automatically matches
the project format in your Avid editing application and you do not need to change it. If you
change the title format in Marquee so that it does not match the project format in your
editing application, you might see artifacts around the edges of some title objects. One
situation in which you might need to change the Marquee title format occurs when you are
creating a title by opening an existing .mqp file. If the .mqp file’s format does not match the
project format in your Avid editing application, you should change the title’s format to
match the project format in your editing application. For more information on changing the
title format, see “Changing Title Formats” in the Marquee Help.

➤

Bug Number: UDEV00162337. Rolling and crawling titles in 24p and 25p projects might
display a “Layout Mismatch” error when in Full Quality mode.
Workaround: Select another quality mode. The error also goes away if you toggle to the
HD project equivalent and load the title.

➤

Bug Number: UDEV00163549. When you re-edit a Marquee title in the Timeline, you
might see artifacts in the video background. This is cosmetic only and does not appear in the
resulting title.
Workaround: If you reedit the title in the bin rather than the Timeline, the artifacts do not
appear.

➤

Bug Number: UDEV00161170. Page breaks appear on rolling and crawling titles when an
HD title is over SD media, or an SD title is over HD media.
Workaround: Recreate the title at the same resolution as the underlying video.
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➤

Bug Number: UDEV00136646/UDEV00136165. HD titles appear aliased when you are
not in Effect mode. Some titles you create in HD projects might look aliased (blocky) when
you view them at Full Quality in Source/Record mode. To improve the visible quality, render
the title or view it in Effect mode.

➤

Bug Number: UDEV00138188. Rolling titles created in SD and rendered in HD display 1
line at the top of the matte when they are rendered.
Workaround: Recreate the title and matte before you render.

➤

Bug Number: UDEV00135729. If you change the size of text, it might yield different
kerning results. If you highlight text and change the text properties, the kerning result might
be different than if you had changed the text properties in the Parent text box. For consistent
results, change the text properties in the Parent text box.

➤

Bug Number: UDEV00140546, and UDEV00140564. When you edit large or unrendered
SD crawling or rolling titles in an HD project, switch to SD, promote the title to Marquee,
save the title in SD, then open the title in HD.
This workaround is not possible for a 720p project, but you can open the 720p bin in a 30i
project and modify the title there, as long as there is an SD version of the sequence.

➤

Bug Number: UDevC00121500. Images imported to Marquee might look blurry and
stretched in the Timeline when compared to images imported into a bin.

Trim
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➤

Bug Number: UDevC00150795. If you select a transition for trimming and disable the
Smart tool, the trim selection is cleared if you then click outside the active zone for the trim
edit. This does not occur if the Smart tool is enabled.

➤

Bug Number: UDevC00143161. When you enable trim editing by pressing Ctrl+Trim
Mode button (Windows and Macintosh) or Ctrl+U (Macintosh), only the transition nearest
the position indicator is selected, instead of transitions on all enabled tracks nearest the
position indicator. Also, enabling trim editing with this keyboard shortcut disables all tracks
except for the ones with trim sides selected.

➤

Bug Number: UDevC00143159. If you perform an overwrite trim using one of the
TrimLeft/Right [frames] buttons and moving in a direction opposite from the selected trim
handle, the trim ripples segments in your sequence instead of overwriting them. For
example, if you make a trim selection on the A-side (outgoing) segment, and then use the
Trim Right 10 Frames button, the trim adds frames to the outgoing segment but does not
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remove frames from the incoming segment as it moves the transition. Instead, it ripples the
segments to the right of the selected transition. This might cause a sync break in your
sequence. This also occurs when you use the keyboard shortcuts for these buttons:
Trim Left/Right [frames] button

Shortcut

Trim Left 10 Frames

Press the M key.

Trim Left 1 Frame

Press the comma (,) key.

Trim Right 1 Frame

Press the period (.) key.

Trim Right 10 Frames

Press the forward slash (/) key.

Workaround: To perform an overwrite trim without rippling the segments on the other side of the
transition, select the Overwrite trim tool in the Timeline palette and then click and drag in the direction
you want to trim, or use the numeric keyboard to enter the number of frames you want to trim.

XDCAM
➤

Bug Number: UDevC00120079. If you are working with the PDW U1 device and you
have “Automatically Import Proxies when disk is inserted” selected in the XDCAM Import
Settings window, you will not receive the automatic prompt to import the proxy clips when
the disk is inserted. For this device, you must manually import the proxy clips. The high
resolution batch import process has not changed.

➤

Bug Number: UdevC00121377. (XDCAM writeback) If you export a 720p50 or 720p59
sequence with an odd number of frames, you will receive a message indicating the sequence
needs an even number of frames to export successfully. Add or subtract a frame and perform
the export again.

➤

Bug Number: UDevC00117308. You might experience dropped frames when playing back
XDCAM media with effects. When playing back media, a number of variables affect play
performance; such as your CPU power, GPU power, sequence complexity and the raster
settings. Depending on the complexity of your sequence, you might need to render some
effects if you want to preview them in real time and at full quality, or before you can output
a finished sequence.

➤

Bug Number: UDevC00116558. When you batch import XDCAM clips from a virtual
volume, the system re-imports the proxy media into your bin. If you batch import XDCAM
clips directly from the XDCAM disk, this works as intended. If you do not have access to the
XDCAM disk, Avid recommends that you import the hi-res XDCAM media when you
import from a virtual volume and then edit your sequence.
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➤

Bug Number: . When you import XDCAM files, be aware that Avid does not support the
batch import workflow when you are working in the following Sony XDCAM camera
modes: Picture Cache Record Mode, Interval Record Mode, or VFR (Variable Frame Rate)
Mode (UCC/OCC - Undercrank/Overcrank). An error message appears which informs you
that the video is not supported. However, the High-Rez versions of these clips can be
imported. Their timecode values, however, will be inaccurate. The Avid editor appends its
own generic timecode to clips recorded in any of the previously mentioned modes.

➤

Bug Number: UdevC00164589. XDCAM proxy media will not export to a QuickTime
reference movie.
If you export as a regular QuickTime movie, MPEG 4, or as Windows Media 9, the export is
successful. Or, you can transcode the proxy sequence to DV 25 or MPEG-IMX and then
export as QuickTime reference.
Workaround: Import the whole XDCAM HD clip and then transcode it.

Extending Your Usable Address Space and Adding
RAM for Improved Performance (Windows)
The Microsoft Windows XP operating system limits every program to 2 gigabytes (GB) of
address space. It reserves the remaining 2 gigabytes of address space for its own use. The
operating system includes a boot-time mechanism that allows applications access to a larger
virtual address space than was previously available. Avid provides a utility for setting the
boot-time mechanism to extend the process address space.
For Windows Vista 64-bit or Windows 7 64-bit operating systems, applications are allocated
an address space well beyond the 2-gigabyte limit allocated by the 32-bit operating systems.
No utility is needed to tell the 64-bit operating systems to allocate additional memory for the
applications.
Setting your Avid editing system to access a larger virtual address space might improve
working with HD projects without running out of memory. Even though you might gain
more memory space, this can be quickly consumed with bins and complex HD effects. For
best performance, if you choose to extend your address space beyond 2 gigabytes, you
should install an additional 1 or 2 GB of RAM.

Using Install3GB.exe to Extend Your Usable Address Space
It is not necessary to run this executable on Windows Vista 64-bit systems or Windows 7
64-bit systems. Perform this procedure on Windows XP systems.
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Documentation Changes

To extend the application address space:

1. Double click the Install3GB.exe file in the Utilities\3G folder where the Avid
application is installed.
A window opens. You must have administrative privileges to run this utility.

n

The hardware and software configuration you are running, for example, Nitris DX, Nitris,
Mojo, Mojo DX, or Adrenaline, determines the amount of memory you should allocate for
the application address space.
2. Type the amount of memory you want to allocate for the application space at the
prompt. The recommended settings are:
-

2700 for Mojo and Adrenaline

-

2700 for Mojo DX and Nitris DX

-

2500 for Symphony Nitris Classic

-

2700 for Software Only systems

Install3GB updates the current configuration you are running. It does not create another
one.
After pressing any key the window closes and you will need to reboot the computer.

Restoring the Original Configuration
You can restore the system to the original configuration.
To restore the configuration:

1. Run the Install3GB.exe as described in “Using Install3GB.exe to Extend Your Usable
Address Space” on page 100.
2. Type 0 (zero) for the memory setting.
This removes the “userva” setting in the boot configuration.
3. Reboot the system.

Documentation Changes
The following changes have occurred since the documentation was completed:
FluidMorph Effect Source and Input Parameters

The table in the What’s New document had reversed the reference to incoming and outgoing
video. The table below is correct.
101

Option

Description

Still->Still

Your Avid editing application takes snapshots of the last frame of outgoing
video and the first frame of incoming video and creates an output that is a
morph of the two images.

Stream->Stream

Your application creates the output by morphing the two clips, frame by
frame.

Stream->Still

Your application creates the output by morphing each frame of the outgoing
video with the first frame of incoming video.

Still->Stream

Your application creates the output by morphing the last frame of the outgoing
video with each frame of the incoming video.

Avid Artist Series Controller

When recording automation gain, the Avid Artist controller does not indicate that the
recording mode (Latch mode or Touch mode). This has been fixed. A red LED light for the
Shift + REC/AUTO button indicates Touch mode for the tracks used for automation gain and
pan recording. Latch mode (the default) is indicated by an unlit LED light.
Red Rocket Card Support

The Red Rocket card reference in the PDF documentation should have stated that this card
has been qualified for transcode only when used with a Media Composer software only
system running with a 64-bit OS with local storage. The minimum drivers currently
supported are Red Rocket driver v1.3.2.0 and Red Rocket firmware v1.1.8.6.
In the HPz800, the Red Rocket card can be installed in slot 4 and the local storage controller
(if required) can be installed in slot 3.
In the HPz400, the Red Rocket card can be installed in slot 4 and the local storage controller
(if required) can be installed in slot 5.
In the Mac Pro (Nehalem), the Red Rocket card can be installed in slot 2 and the local
storage controller (if required) can be installed in slot 3.
Finding AMA Information

Avid supplies information about Avid Media Access (AMA) in different forms, they
include: Avid Editing Guide, Avid Editing Help, Avid Editing ReadMe, individual PDF files
about each plug-in located on www.avid.com/ama.
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The following table describes where you can find specific information about the AMA
plug-ins.
AMA Questions

Description

Where to Find It

What is AMA?

About AMA and the steps to perform how to See “The Avid Media Access
link to AMA clips.
(AMA) Workflow” topic in the
File Based Media - AMA chapter
of the Avid Editing Guide or in
the Avid Editing Help.

How will AMA media
affect my system
performance?

Some AMA media is a processor intensive
operation. Older platforms may not offer
optimum performance. See the list of
qualified systems.

What plug-ins are
supported?

Information about each AMA plug-in
See the individual plug-in topic in
including resolutions and formats supported. the File Based Media - AMA
chapter of the Avid Editing Guide
or your Avid Editing Help. See
also the individual plug-in pdf file
on www.avid.com/ama.

Are there any plug-in
limitations?

A list of “gotcha’s” or things you need to
know about each individual plug-in.

See the individual plug-in pdf file
on www.avid.com/ama.

What are the AMA or
plug-in specific bugs
associated with this
release?

Issues or limitations that we have come
across while testing each plug-in.

See the “AMA (Avid Media
Access)” on page 53 section in the
Avid Editing ReadMe. In addition,
some third-party manufacturers
supply their own Release Notes,
see www.avid.com/ama.

Do you have any AMA
workflows?

Generic 1-page workflows for each AMA
plug-in have been created, and an AMA
workflow guide (created by a consultant)
have been created for some of the plug-ins.

See the “Workflows for Editing
with AMA” topic of the File
Based Media - AMA chapter in
the Avid Editing Guide or Avid
Editing Help. Also, see the
individual plug-in pdf file on
www.avid.com/ama. Consultant
created workflow guides are also
at www.avid.com/ama.

See “Feature Performance” on
page 50 in the Avid Editing
ReadMe.
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid
Technology, Inc.
This product is subject to the terms and conditions of a software license agreement provided with the software. The product
may only be used in accordance with the license agreement.
This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.
No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including
photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.
Copyright © 2013 Avid Technology, Inc. and its licensors. All rights reserved.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II,
Assistant Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA,
Avid DNxcel, Avid DNxHD, Avid DS Assist Station, Avid Ignite, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid
MEDIArray, Avid Mojo, Avid Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe,
AVX, Beat Detective, Beauty Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Bruno, C|24,
CaptureManager, ChromaCurve, ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor,
Command|24, Command|8, Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, D-Command, D-Control, Deko,
DekoCast, D-Fi, D-fx, Digi 002, Digi 003, DigiBase, Digidesign, Digidesign Audio Engine, Digidesign Development Partners,
Digidesign Intelligent Noise Reduction, Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack,
DigiSerial, DigiSnake, DigiSystem, Digital Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear,
DINR, DNxchange, Do More, DPP-1, D-Show, DSP Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven,
EM, Euphonix, EUCON, EveryPhase, Expander, ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter,
FilmScribe, Flexevent, FluidMotion, Frame Chase, FXDeko, HD Core, HD Process, HDpack, Home-to-Hollywood, HYBRID,
HyperSPACE, HyperSPACE HDCAM, iKnowledge, Image Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS
ControlAir, InGame, Instantwrite, Instinct, Intelligent Content Management, Intelligent Digital Actor Technology, IntelliRender,
Intelli-Sat, Intelli-sat Broadcasting Recording Manager, InterFX, Interplay, inTONE, Intraframe, iS Expander, iS9, iS18, iS23,
iS36, ISIS, IsoSync, LaunchPad, LeaderPlus, LFX, Lightning, Link & Sync, ListSync, LKT-200, Lo-Fi, MachineControl, Magic
Mask, Make Anything Hollywood, make manage move | media, Marquee, MassivePack, Massive Pack Pro, Maxim, Mbox,
Media Composer, MediaFlow, MediaLog, MediaMix, Media Reader, Media Recorder, MEDIArray, MediaServer, MediaShare,
MetaFuze, MetaSync, MIDI I/O, Mix Rack, Moviestar, MultiShell, NaturalMatch, NewsCutter, NewsView, NewsVision, Nitris,
NL3D, NLP, NSDOS, NSWIN, OMF, OMF Interchange, OMM, OnDVD, Open Media Framework, Open Media Management,
Painterly Effects, Palladium, Personal Q, PET, Podcast Factory, PowerSwap, PRE, ProControl, ProEncode, Profiler, Pro Tools,
Pro Tools|HD, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, QuickPunch, QuietDrive, Realtime Motion Synthesis, Recti-Fi,
Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket Surfer, Reso, RetroLoop, Reverb One,
ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, ScriptSync, SecureProductionEnvironment, Serv|GT,
Serv|LT, Shape-to-Shape, ShuttleCase, Sibelius, SimulPlay, SimulRecord, Slightly Rude Compressor, Smack!, Soft
SampleCell, Soft-Clip Limiter, SoundReplacer, SPACE, SPACEShift, SpectraGraph, SpectraMatte, SteadyGlide,
Streamfactory, Streamgenie, StreamRAID, SubCap, Sundance, Sundance Digital, SurroundScope, Symphony, SYNC HD,
SYNC I/O, Synchronic, SynchroScope, Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, TimeLiner, Titansync, Titan, TL
Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL
Utilities, tools for storytellers, Transit, TransJammer, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Video the Web Way,
VideoRAID, VideoSPACE, VTEM, Work-N-Play, Xdeck, X-Form, Xmon and XPAND! are either registered trademarks or
trademarks of Avid Technology, Inc. in the United States and/or other countries.
Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States
and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other
countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other
countries. All other trademarks contained herein are the property of their respective owners.
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